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Contents at a glance
This handbook contains the information you need to efficiently use ASUS®

MyPal A730W Pocket PC.

• Chapter 1 - Get started! .............................................1-1

This chapter introduces the ASUS MyPal A730W Pocket PC,
how to set and power it up, and basic screens that will
familiarize you with  its many features.

• Chapter 2 - Learn the basics .....................................2-1

This chapter will teach you the basic functions in MyPal
A730W. You will learn how to enter, find, and organize
information, customize the device, and use the bundled simple
applications.

• Chapter 3 - Synchronize and enhance .....................3-1

This chapter tells you how to use the Microsoft® ActiveSync® to
synchronize your device with your desktop computer. To
further enhance your device, refer to the instructions on how to
install other applications from the Companion CD.

• Chapter 4 - ASUS® Programs ....................................4-1

This chapter introduces the ASUS proprietary programs that
came with your device.

• Chapter 5 - Microsoft® Pocket Outlook .....................5-1

This chapter details the procedures for the Microsoft® Pocket
Outlook Calendar, Contacts, Tasks, Notes, and Messaging.

• Chapter 6 - Companion programs ............................6-1

This chapter includes information on Pocket Word, Pocket
Excel, MSN Messenger, and Windows Media Player for
Pocket PC.
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• Chapter 7 - Pocket Internet Explorer ........................7-1

This chapter gives information on using Pocket Internet
Explorer, Mobile Favorites folder, and AvantGo interactive
service.

• Chapter 8 - Get connected ........................................8-1

This chapter provides the procedures for connecting to the
Internet, and for transferring data using infrared (IR).

• Chapter 9 - Bluetooth® ........................................................................ 9-1

This chapter provides information on using the Bluetooth
feature built-in the device.

• Chapter 10 - Using Wi-Fi® ............................................................. 10-1

This chapter provides information on using the Wi-Fi® feature
built-in the device.

• Appendix - Notices ................................................... A-1

This part includes the safety notices and regulations.
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MyPal A730W specifications

Processor

Operating
system

Memory

Display

Battery

Card slot

Connection

Audio

Camera

Size

Weight

Intel® PXA270 520 MHz

Microsoft® Windows Mobile™ 2003 Second
Edition

64 MB Flash ROM
128 MB SDRAM (107 MB user accessible)

3.7-inch, brilliant transflective LCD
65,536 colors, 16-bit display
VGA 640 x 480 resolution

1100 mAh Lithium Ion
Built-in backup battery 20mAh

CompactFlash Type II card slot (3.3V)
SD card slot (3.3V) (for SD memory cards and

SDIO interface cards)

Wi-Fi® (IEEE 802.11b)
Bluetooth® v1.1
Infrared 115.2 Kbps

3.5 mm stereo headphone jack
Built-in microphone and speaker

Built-in 1.3 Megapixel resolution
ASUS Camera interface program

117.5 mm x 72.8 mm x 16.9 mm (L x W x H)
4.63 in. x 2.87 in. x 0.66 in.  (L x W x H)

170 g
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Package contents
Your package includes several accessories for the Pocket PC. After
unpacking, check the items against the list below and make sure that they
are in good condition. If any item is missing or damaged, contact your
dealer or retailer immediately.

Standard items

• ASUS MyPal A730W

• Cradle

• USB sync cable

• AC adapter/power cable
Input : 100V ~ 240V
Output : 5V 2.4A 10W

• 1100 mAh Lithium Ion battery

• Stylus

• Protection case

• Microsoft® Companion CD

• Bonus CD

• Handbook

• Quick Start Guide

• Warranty card

Optional accessories

• Stylus

• Car charger

• Leather protection case

• Traveling USB sync cable

• Traveling USB host cable

• Traveling serial cable

• AC adapter/power cable (UL/CEE/UK/SAA/CCEE)

• GPS solution kit

• Bluetooth® GPS solution kit

• Extension battery (1800 mAh)
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Introducing MyPal
The ASUS® MyPal A730W is truly a good companion wherever you go.
Powered by a 520 MHz Intel® PXA270 processor, equipped with 128 MB
SDRAM and 64 MB Flash ROM, and bundled with the Microsoft® Windows
Mobile® 2003 Second Edition plus a host of useful utilities, you have
everything you need in your pocket!

Front features

• Power LED - blinks green when the battery is charging; steady green
when the battery is fully charged and the device is connected to an AC
power source.

• Bluetooth LED - lights up blue when the Bluetooth® feature is ON.

• Wi-Fi LED - lights up blue when the Wi-Fi feature is ON.

• LCD touch screen - allows you to enter, read, send, receive, or edit data
by tapping on it. The screen lumination is increased or decreased by
changing the backlight settings.

• Microphone - magnifies your sound recording.

LCD touch screen

4-way Navigation button

Tasks button
Contacts button

ASUS Launcher button

Calendar button

Bluetooth LED Power LED

Microphone

Launch button

Wi-Fi LED
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• ASUS Launcher button

- While in the main screen (Today screen), press once to start the
ASUS Launcher program

- While in the main screen (Today screen), press and hold for several
seconds to launch the ASUS Camera program

- While recording a video (ASUS Camera recorder mode), press once
to stop recording. See the section “Recorder functions” on page 4-13
for more information on video recording.

• Calendar button
- While in the main screen (Today screen), press once to launch the

calendar program

- While in camera preview (ASUS Camera photo mode), press once to
turn on the photo frame selection feature and display the first
available frame. A different frame appears whenever you press the
button. The feature is turned off after the last available frame is
displayed. See the section “Photo menus” on page 4-16 for details on
changing photo settings.

• Contacts button
- While in the main screen (Today screen), press once to launch your

contacts list

- While in camera preview (ASUS Camera photo/recorder mode),
press once to change the capture mode (lighting effects). The
capture mode changes whenever you press the button. See the
section “Photo menus” on page 4-16 for details on changing photo
settings.

• Tasks button
- While in the main screen (Today screen), press once to launch your

tasks list

- While in camera preview (ASUS Camera photo/recorder mode),
press once to change the image capture resolution (default is
640*480 pixels). The resolution changes whenever you press the
button. See the section “Photo menus” on page 4-16 for details on
changing photo settings.

• 4-way navigation button - functions like the four arrow keys on a
keyboard. This button allows you to move through the program icons,
folders, or files in a menu by scrolling up or down, left or right.



1-4 Chapter 1

Back features

NOTE The back cover is removable, and allows you to remove or
replace the main battery. Refer to section “Setting up MyPal”
on page 1-8 for instructions.

• Camera lens - allows you to focus and take a photo or video of a
subject.

CAUTION! DO NOT touch the camera lens!

• Camera flash - provides additional light when capturing videos or
images. You can turn the flash on or off while in the ASUS Camcorder
interface. Refer to Chapter 4 for information.

• Speaker - allows you to hear alarms and other sound outputs from the
device.

• Back cover - provides protection to the internal parts of the device.

Camera lens

Speaker

Camera flash

Back cover

• Launch button - functions like the enter/return key on a keyboard.

- Press once to launch a selected program, list folders contents, or
open a file.

- While in camera preview (ASUS Camera photo/recorder mode),
press once to turn the camera flash on, press again to turn the flash
off.
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Side features

• Power/Backlight button - turns the device power on or off if you press
the button quickly. Press and hold the button for a few seconds to turn
the backlight on or off. Turning off the backlight saves battery power.

NOTE Press the Power button and the Tasks button simultaneously
if you wish to launch the Align Screen function.

• Camera / Notes /Record button
- While in the main screen (Today screen), press once to launch the

Notes program.

- While in the Notes program, press and hold to start recording,
release to stop recording.

- While in the ASUS Camcorder program, press once to take a photo
shot (Photo capture mode); or press once to start recording a video,
press again to stop recording (Video recorder mode)

• Back cover latch - secures the back cover to the main unit.

NOTE As a precaution, the power button is automatically disabled
when you remove the back cover. You can only turn on the
power when the back cover is installed to the unit.

Right side

Back cover latch

Left side

Camera/Notes/Record button

Power button/
Backlight button
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Top features

Bottom features

• Headphone jack - connects a headphone.

• CF card slot - accommodates a CompactFlash (CF) card.

• SD card slot - accommodates an SD memory card or an SDIO interface
card (e.g. 802.11b, Bluetooth®, GPS, camera, barcode scanner, etc.)

• Infrared (IR) port - allows you to copy or send data to another device
with an IR port.

• Cradle connector / Sync cable connector - connects to the 26-pin
female connector on the cradle. If you are not using the cradle, connect
the 26-pin USB sync cable directly to this connector to synchronize your
device with your computer.

• Reset switch - allows you to perform a soft reset in case the device
malfunctions, or when an application hangs. Press the tip of the stylus on
this switch to reset the system.

NOTE To perform a hard reset, press and hold the power button
while you press the tip of the stylus on the reset switch. A
hard reset restores the original configuration of your device
and erases all data. Back up your data before performing
a hard reset!

• Stylus - used for tapping or writing on the LCD touch screen.

Cradle connector /
Sync cable connector

Reset switch

Stylus

CF card slotHeadphone jack

SD card slotInfrared (IR) port
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The cradle
The cradle has four key parts.

• Device connector - holds the device on the cradle, and functions as a
synchronization interface. This is a 26-pin connector that matches the
connector on the bottom of the device.

• Stylus holder - provides a convenient place for the stylus when the
device is on the cradle.

• USB connector - synchronizes the device with your PC.

• Power connector - connects the bundled AC adapter.

The stylus
The stylus functions on a Pocket PC the same way a
mouse functions on a standard PC. Use the stylus to tap
or drag on the LCD touch screen to open programs or
execute commands.

• Tap. Touch the screen once with the stylus to open
programs and select options.

• Drag. Hold the stylus on the screen and drag across
the screen to select text and images. Drag in a list to
select multiple items.

• Tap and hold. Tap and hold the stylus on an item to
see a list of actions available for that item. From the
pop-up menu, tap the action that you wish to perform.

Device connector USB connector

Power connector
Stylus holder

Slide out the
stylus from the
compartment
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Setting up MyPal

Removing and replacing the back cover

To remove the back cover:

1. Locate the latch on the right side
of the device, then use the stylus
to push the latch toward the
“unlocked” icon.

2. Carefully slide the cover downward
until it is disengaged from the
device.

NOTE As a precaution, the power button is automatically disabled
when you remove the back cover. You can only turn on the
power when the back cover is installed to the unit.
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To replace the back cover:

1. Carefully slide the cover
from the bottom of the
device making sure that
the side rails match the
grooves on the side of
the device.

2. Use the stylus to push the latch
toward the “locked” icon.

Groove

Rail
(on inner side)
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Installing and removing the battery

3. Push the battery upward until you
hear the battery latch click,
indicating that the battery is locked
in place and the battery contacts
matched the 4-pin connector on the
compartment.

NOTE You need to remove the back cover to access the battery
compartment. Refer to the section “Removing and replacing
the back cover” on page 1-8 for instructions.

To install the battery:

1. Position and insert the right side
of the battery with its notches
matching the tabs on the right
side of the compartment.

2. Press the left side of the battery
to completely fit it into the
compartment.

NOTE In addition to the external battery, the device includes a
20 mAh built-in backup battery. The backup battery contains
the original configuration of your device.

Battery latch locked

Battery contacts

Tabs on the battery
compartment

RESET

NOTE At this point, the bottom edge of the battery should fit the
bottom edge of the compartment.
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To remove the battery:

1. Use the stylus to push and unlock
the battery latch.

2. Push the battery downward to
disengage it from the battery
contacts on the compartment.

3. Flip up the upper edge of the battery to
remove it from the compartment.

Placing on the cradle
Position the device on the cradle as shown. Match the connectors and
carefully insert the device until it fits in place.

Battery latch unlocked
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Connecting the AC adapter

IMPORTANT You need to charge the battery before using the device for
the first time.

To connect the AC adapter without the cradle:

1. Connect the power cable to the jack on the sync cable adapter.

2. Connect the 26-pin device plug of the sync cable to the 26-pin
connector on the bottom of the device.

3. Connect the power plug to a grounded wall socket.

To connect the AC adapter with the cradle:

1. Connect the power
cable to the
connector at the back
of the cradle.

2. Connect the power
plug to a grounded
wall socket.

NOTE The power LED (green) blinks and starts charging the battery
as soon as you connect the power cable to a power source.
See page 2-25 on how to display the battery power status.

1

2

RESET

Pocket PC

AC adapter/ Power cable

USB sync cable

Sync cable adapter

26-pin device plug

1

2

3
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Additional storage
Your device comes with two kinds of memory card slots for additional
storage. The CF card slot supports multimedia cards. The SD card slot
supports SD (SecureDigital) memory card and SDIO cards of various
functionalities including 802.11b, Bluetooth®, GPS, camera, etc.

NOTE You need to install an SD memory card or CF card if you wish
to use the ASUS backup features.

NOTE An SD/SDIO card fits only in one orientation, and slides
smoothly into the slot if inserted correctly. DO NOT force the
card into the slot!

Installing and removing an SD/SDIO card

To install an SD/SDIO card:

1. With the label side (usually the
side with the card manufacturer’s
name) face up, and the barcode/
serial number side face down,
insert the card into the SD card
slot.

To remove an SD/SDIO card:

Press the card slightly until it ejects.

Label side

2. Push the card all the way into the slot until it fits completely. If properly
installed, the SD card edge aligns with the top edge of the device.
SDIO cards usually have an extended part that protrude over the slot
edge.
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NOTE A CF card fits only in one orientation, and slides smoothly into
the slot if inserted correctly. DO NOT force the card into the
slot!

Installing and removing a CF card

To install a CF card:

1. With the label side (usually the side with the card manufacturer’s
name) face up, and the barcode/serial number side face down, insert
the 50-pin female connector of the card into the CF card slot.

2. Push the card all the way into the slot until it fits completely. If properly
installed, the CF card edge aligns with the top edge of the device.

To remove a CF card:

Simply pull out the card from the slot.

Label side
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Activating MyPal
You need to properly calibrate and activate your device before using it.
This process ensures accurate positioning when entering text and
selecting menus.

To calibrate and activate your device:

1. Press the power button.

The Align screen appears when you turn on the
device for the first time, or after performing a hard
reset.

Power button

2. Use the stylus to tap the center of the
cross to perform the align screen
process. You may have to do this step a
few times to properly calibrate.

5. When prompted, select your time zone.

6. When the Today screen appears, you
are ready to use your device. Proceed to
the next section for information on the
basic screens on your device.

NOTE To perform a hard reset, press and hold
the power button while you press the tip
of the stylus on the reset switch.

NOTE To launch the Align Screen
function at any time, tap , tap
Settings, then the System tab.
Tap the Screen icon, then the
Align Screen button.

4. Follow the screen instructions until setup
is complete.



1-16 Chapter 1

Basic screens on MyPal

Today screen
Normally, the Today screen appears when you turn on your device for the
first time each day.

NOTE When the device is already on and the screen displays
another program, you may return to the Today screen any

time by tapping the  icon. Then from the Start menu, tap
Today.

As shown in the sample below, the Today screen lets you see at a glance
the summary of the important information for the day.

From the Today screen, tap any of the listed items with the stylus to
display the details. See “Chapter 2: Learn the basics” on how to modify the
current tasks or activities, or to add new items or information.

Tap to switch
to a program

Tap to set up or change network or modem connections
Tap to change volume or mute all sounds

Tap to display the date, time,
and your next appointment

Tap to change the date and time

Your day at a glance

Tap to display the Wi-Fi menu
Tap to create a new item

Tap to view PC connection status

Tap to shift display to landscape or portrait orientation

Tap to display the Bluetooth menu
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Command bar
At the bottom of the screen is the Command bar. You can use the menus
and buttons on the Command bar to perform tasks in programs.

NOTE The menus and buttons vary depending on the programs you
are using.

Start menu
From the Start menu, you can select programs, settings, and help topics.

To display the Start menu, tap the  icon from the top of the screen.

Tap to select menu
commands

Tap to select
button commands

Tap to display
the input panel

Tap to open a recently used program

Tap to open a program

Tap to open the Programs menu

Tap to open the Settings menu

Tap to display the Help topics
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Pop-up menus
With the pop-up menus, you can easily choose an action for an item. For
example, you can use the pop-up menu in File Explorer to delete, copy,
or beam an item.

To access a pop-up menu, tap and hold the stylus on the item that you
wish to perform action on. When the menu appears, lift the stylus, and tap
the action that you want to execute. To close the pop-up menu without
performing an action, tap anywhere outside the menu.

Tap and hold until the pop-up menu appears

Tap the action that you wish to perform

Tap outside the pop-up menu to close it
without performing an action

NOTE The pop-up menus are also available in most other programs
on your device; however, the pop-up menu items vary
depending on the program or application.
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Viewing system information
Your device allows you to easily display the built-in specifications.

NOTE You can not change the information you see in the system
information screens.

To display the system information:

1. Tap  , then tap Settings.

2. Tap the System tab on the bottom of
the Settings screen.

3. Tap the System Information icon to
display the device specifications. This
screen is displayed whenever you tap
the Device Info tab.

4. Tap the Memory tab to display the device memory information.

5. Tap the Wireless LAN tab to display the wireless LAN information.

6. Tap the Others tab to display additional device information.



Learn the basics 2-3

Entering information
You can enter information in your device in any of the following ways:

• Use the input panel to enter text using the soft keyboard or the Letter
Recognizer

• Write directly on the screen with the stylus

• Draw pictures on the screen

• Speak into the device microphone to record a message

• Use the Microsoft® ActiveSync® to synchronize or copy information from
your desktop computer to your device

Entering text using the Input Panel
Use the Input Panel to enter information in any program on your device.
You can either type using the soft keyboard or write using the Letter
Recognizer, Block Recognizer, or Transcriber. In either case, the
characters appear as typed text on the screen.

To show or hide the input panel, tap the Input Panel button. Tap the arrow
next to the Input Panel button to see your options.

To type with the soft keyboard:

1. Tap the arrow next to the Input Panel button, then tap Keyboard.

NOTE For a demonstration, open Notes.

2. Tap the keys with the stylus to enter information.

Select an input method

Tap to show or hide the input panel

Tap to display the input method options
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Word completion feature
When you use the Input Panel and the
soft keyboard, your device anticipates
the word you are typing and displays it
above the Input Panel. When you tap
the displayed word, it is inserted into
your text at the insertion point. The
more you use your device, the more
words it learns to anticipate.

To change options on the
word completion feature:

1. Tap   .

2. Tap Settings.

3. Tap Personal tab.

4. Tap Input.
5. Tap Word Completion tab.

6. Make your desired changes.

To use Letter Recognizer:

With the Letter Recognizer, you can write letters on the screen with the
stylus as you would on paper.

1. Tap the arrow next to the Input Panel
button, then tap Letter Recognizer.

2. Write a letter in the box.

When you write a letter, it is converted
to a typed text that appears on the
screen. For instructions and a
demonstation on using the Letter
Recognizer, tap the question mark
next to the writing area.

Tap here if this is the word you wish to use
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To use Block Recognizer:

With the Block Recognizer, you can input
character strokes that are similar to those
used on other devices.

1. Tap the arrow next to the Input Panel
button, then tap Block Recognizer.

2. Write a letter in the box.

When you write a letter, it is converted
to a typed text that appears on the
screen. For instructions and a
demonstration on using the Block
Recognizer, tap the question mark
next to the writing area.

To use Transcriber:

With Transcriber, you can use the stylus
to write anywhere on the screen as you
would on paper. Unlike Letter Recognizer
and Block Recognizer, you can write a
sentence or additional information. Pause
after writing and let Transcriber convert
the written characters to typed characters.

1. Tap the arrow next to the Input Panel
button, then tap Transcriber.

2. Write anywhere on the screen.

For instructions and demonstration on
using Transcriber, with Transcriber
open, tap the question mark in the lower right corner of the screen.

To edit typed text:

1. Select the text that you wish to edit using either one of the following:

• drag the stylus over the text
• tap twice to select a word
• tap three times to select a paragraph

2. Tap Edit on the Command bar and select an action, or use one of the
tools in the Input Panel to enter a new text.
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Writing on the screen
In any program that accepts writing, such as the Notes program, and in the
Notes tab in Calendar, Contacts, and Tasks, you can use the stylus to
write directly on the screen. Write the way you do on paper. You can edit
and format what you have written and convert the writing to text at a later
time.

To write on the screen:

1. Open the Notes program.

2. Tap the Pen button to switch to the writing mode. The screen displays
blank space with lines to help you write.

3. Write your text.

NOTE Some programs that accept writing may not have the Pen
button. See the documentation for that program to find out
how to switch to writing mode.

Tap the Pen button and use
your stylus like a pen

Write your text here
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To edit your writing:

1. Tap and hold the stylus next to the text that you wish to select until the
insertion point appears.

2. Without lifting, drag the stylus across the text to select it.

If you accidentally write on the screen, tap Tools, then Undo and try
again. You can also select text by tapping the Pen button to deselect it,
then dragging the stylus across the screen.

3. Tap Edit on the Command bar and select an action, or use one of the
tools in the Input Panel to enter a new text.

To convert writing to text:

• Tap Tools, then Recognize.

To select a zoom level:

• Tap Tools, then tap a zoom percentage from the options.

The writing is turned into text
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If the conversion is incorrect, you can select different words from a list of
alternates or return to the original writing.

1. Tap and hold the incorrect word.

2. When the pop-up menu appears, tap Alternates to display a list of
alternate words for the selection.

3. Tap the word that you want to use, or tap the writing at the top of the
menu to return to the original writing.

Tips for getting good writing recognition
• Write neatly.

• Write on the line and draw descenders below the line. Write the cross of
the “t” and apostrophes below the top line so that they are not confused
with the word above. Write periods and commas above the line.

• For better recognition, try increasing the zoom level to 300% using the
Tools menu.

• Write the letters of a word closely and leave big gaps between words so
that the device can easily tell where the words begin and end.

• Hyphenated words, foreign words that use special characters such as
accents, and some punctuation cannot be converted.

• If you add writing to a word to change it after the word has been
recognized, the writing that you added will be included when you try to
recognize the writing again.

Tap to return to your
original writing

Or, tap the word that
you want to use
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Drawing on the screen
You can draw on the screen in the same way that you write on the screen.
The difference between writing and drawing on the screen is how you
select items and how they can be edited. For example, selected drawings
can be resized, while writing cannot.

To create a drawing:

1. Use the stylus to make a stroke that extends over three lines on the
screen. A drawing box appears around the stroke.

NOTE If the drawing does not cross over three lines, the drawing
box does not appear.

2. Continue drawing. If your subsequent
strokes extend outside the box, you
will notice that the drawing box
expands to enclose all the strokes.

NOTE To easily work on or view your drawing, change the zoom
level by tapping Tools and selecting your desired zoom.

To edit your drawing:

1. Tap and hold the stylus on the drawing until the selection handle
appears. To select multiple drawings, deselect the Pen button, then
drag to select the drawings you want.

2. Tap and hold the selected drawing, then tap an editing command on
the pop-up menu or tap a command on the Edit menu.

3. Resize the drawing by deselecting the Pen button (if selected) and
dragging a selection handle to your desired size.

The drawing box indicates the
boundaries of the drawing

Pen button
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Recording a message
In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording a
message. In Calendar, Tasks, and Contacts, you can include a recording
in the Notes tab. In the Notes program, you can either create a standalone
recording or include a recording in a written note. If you want to include the
recording in a note, open the note first. In the Inbox program, you can add
a recording to an e-mail message.

To create a recording:

1. Tap  , tap Programs, then tap Notes.

or

Tap New, then tap Note.

2. Tap the Record icon from the command bar to display the recording
toolbar.

3. Hold your device with the microphone near your mouth or other source
of sound.

4. Tap the Record button (red button) to begin recording. To stop
recording, tap the Stop button. You will hear two beeps when you stop
recording.

NOTE To record, you may also press and hold  the Record button
on the left side of the device. To stop recording, release the
Record button.

Indicates an embedded recording

Tap to show or hide the
Recording toolbar

Tap to begin recording

Tap to stop recording
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To change the recording format:

1. In the note list, tap Tools then
Options.

2. Tap the Global Input Options link.

3. Tap the Options tab.

4. Tap the down arrow on the Voice
recording format box to display the
available options.

5.  Select your desired format then tap
OK when done.

NOTE Compared to other settings, the Pulse Code Modulation
(PCM) provides slightly better sound quality but takes up 50
times more storage space tham Mobile Voice recordings.

6. The new recording appears in the
Notes list, or as an embedded icon. To
play the recording, tap it from the list,
or if embedded in a note, tap the
speaker icon.
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Finding and organizing information
The Find and Help features on your device helps you quickly locate
information.

Using the Find function

To find information:

1. Tap , tap Help, then tap Find.

2. Enter the text that you want to find,
select a data type, then tap Go to start
the search. To quickly find information
that is taking up space on your device,
select Larger than 64 KB in Type.

To use the Help feature:

1. Tap  , then tap Help.

2. Tap a link to the topic that you wish to
display.

Type a word to find
Tap to search for the word

Topics found containing
the searched word
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Using the File Explorer

To use the File Explorer to find and organize files:

1. Tap  , then tap Programs.

2. In the Program screen, tap the File Explorer icon to display the files in
your device.

Tap to select a sort order

Tap to display sort options

Tap to display the contents of My Documents folder

Tap to display the contents of the
Flash disk or the storage card

Tap to open a path to a network
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Customizing your device
You can customize your device by adjusting the settings, using the built-in
programs, and installing additional software.

To see the available options:

1. Tap  , then tap Settings to display the Settings screen.

2. Tap the Personal or System tab on the bottom of the screen.

NOTE Tap and hold the slider on the right side of the screen to
display other Settings icons.
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Changing the date and time

To change the date and time settings:

1. Tap  , tap Settings, then tap the System tab.

2. Tap the Clock & Alarms icon.

3. Make your desired settings.

To change the alarm settings:

1. Tap  , tap Settings, then tap the System tab.

2. Tap the Clock & Alarms icon, then tap the Alarm tab.

3. Make your desired settings.

Tap to select a time zone

Highlight a Time item then
tap up or down arrow to set

Tap this down arrow to
display the Calendar

Tap a day of the week for the alarm

Tap and type a description for the alarm

Tap to display the clock and
specify a time for the alarm
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Changing the Start menus

To change the menu items:

1. Tap  , tap Settings, then tap the
Menus icon.

2. Check the box opposite the items that
you wish to appear on the Start Menu.

3. Tap the New Menu tab.

4. Select the items that you wish to
appear on the New menu (located on
the lower left corner of the main
screen).
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Changing the owner information

To change the owner information:

1. Tap  , tap Settings, then tap the Owner Information icon.

2. Key-in the data that you wish to appear on the Today screen.

3. Add notes to the owner information by tapping the Notes tab.

4. Key-in your desired text.

5. Tap the Options tab, then select the items that you wish to appear
onscreen whenever you turn on the device. Tap OK when done.
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Setting a password

To set a password for your device:

1. Tap  , tap Settings, then tap the Password icon.

2 Check the box Prompt if device unused, then select the period from
the available options by tapping the down arrow.

3. Select the password type, Simple 4 digit or Strong alphanumeric.

4. Key-in a password. If you selected the Strong alphanumeric type of
password, you need to key-in the password twice.

5. Tap the Hint tab to create a kind of
reminder in case you forget your
password.

6. Tap OK when done.
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Changing the screen display orientation

To change the screen display orientation:

1. Tap  , tap Settings, then tap the System tab.

2. Tap the Screen icon to show the screen options.

3. Select your desired orientation, then tap OK.

NOTE To quickly change the screen display orientation, simply tap
the   icon on the lower right corner of the screen.

Portrait orientation

This setting Shows this screen

Sets the screen display
to portrait or landscape
orientation
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Landscape orientation (right-handed)

Landscape orientation (left-handed)

This setting Shows this screen

This setting Shows this screen
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To enable the ClearType feature:

1. Tap  , tap Settings, then tap the
System tab.

2. Tap the Screen icon to show the
screen options.

3. Tap the Clear Type tab.

4. Check the Enable Clear Type box,
then tap OK.

To change the screen text size:

1. Tap  , tap Settings, then tap the
System tab.

2. Tap the Screen icon to show the
screen options.

3. Tap the Text Size tab.

4. Move the slider toward the Smallest
or Largest until you attain your
desired text size. Tap OK.

Smaller text Larger text

NOTE The slider is on the center of
the line by default.
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Changing the screen theme

To change the screen theme:

1. Tap  , tap Settings, then tap the Today icon.

2. Select your desired theme from the available options.

or

Check the box Use this picture as the background, then tap Browse
to select an image from your picture files.

3. Tap OK when done.

To specify the items to appear on the Today screen:

1. Tap  , tap Settings, then tap the
Today icon.

2. Tap the Items tab.

3. Check the box opposite your desired
items. Tap OK when done.
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Changing the button assignments

To change the button assignments:

1. Tap  , tap Settings, then tap the
Buttons icon.

2. Highlight a button by tapping on it.

3. Tap the down arrow to display the
programs that you can assign to the
button.

4. Repeat steps 2 to 3 to change other
button assignments.

5. Tap OK when done.

To customize the speed of your Up/Down button control:

1. Tap the Up/Down Control tab.

2. Tap the slider to your desired settings.

3. Tap OK when done.



2-24 Chapter 2

Setting the backlight

To set the backlight:

1. Tap  , then tap Settings.

2. Tap the System tab, then tap the
Backlight icon.

3. Adjust the display brightness by
dragging the slider towards Dark or
Bright until you achieve your desired
screen brightness.

4. Tap the Battery Power tab and customize the backlight settings when
using battery power.

5. Tap the External Power tab and customize the backlight settings when
using AC power.

6. Tap OK when done.
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Changing the battery power settings

To change the battery power settings:

1. Tap  , then tap Settings.

2. Tap the System tab.

3. Tap the Power icon to display the
battery power status. This screen
shows the detected percentages of the
remaining battery power. You may not
change the information on this screen.

4. Tap the Advanced tab to customize
the settings for the battery to conserve
power.

5. Tap OK when done.
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Selecting sounds and notifications
Your device can remind you of things you have to do in several ways. For
example, if you have set up an appointment in Calendar, a task with a due
date, or an alarm in Clock, you will be notified in any of the following ways.

• A message box appears on the screen

• A sound is played (you can select the type of sound)

• A light flashes on the device

To set sounds and notifications:

1. Tap , then tap Settings.
2. From the Settings screen, tap the

Sounds & Notifications icon to
display the Sounds tab.

3. Select the items that you wish to
enable.

4. Tap the Notifications tab and set the
event notification details.

5. Tap OK when done.
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Changing the audio settings

To change the Audio settings:

1. Tap  , then tap Settings.

2. Tap the System tab, then tap the
Audio Settings icon to display the
audio settings screen.

3. Adjust the volume, balance, treble, and
bass, and stereo settings by dragging
the slider to the left or to the right until
you achieve your desired sound output.

4. Tap OK when done.

To change the Microphone settings:

1. Tap the MIC tab from the audio
settings screen.

2. Adjust the recording volume to high or
low by dragging the slider to the left or
to the right.

3. Check the box opposite Automatic
Gain Control (AGC) to adjust the
settings for the microphone sensitivity.
The AGC feature allows you to adjust
the recording and environment noise
level.

4. Select either MIC or Headset to use
as input by checking the appropriate
box.

NOTE Tap the Default button to
restore the default audio
settings.
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Changing the system operation settings

To change the system operation settings:

1. Tap  , then tap Settings.

2. Tap the System tab, then tap the
System Settings icon to display the
system operation mode options.

3. Make your desired changes.

The Turbo Mode allows better CPU
performance. Set to this mode when
playing games or playing video.
However, setting to Turbo mode may
reduce the battery life.

The Standard Mode allows for a
normal CPU speed and more stable
performance. Set to this mode when listening to MP3 audio files or for
applications  that do not require very fast CPU speed.

The Power Saving Mode sets the CPU to a lower speed. This mode
has a lower CPU performance but extends the battery life. Set to this
mode when using text based applications such as Word, Excel, etc.

For automatic power saving, check the box opposite Enable
Automatic Mode. This mode adjusts the CPU speed depending on the
program that you are running.

4. Tap OK when done.
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To change the Wakeup settings:

1. Tap  , then tap Settings.

2. Tap the System tab, then tap the
System Settings icon.

3. Tap the Wakeup tab to display the
wakeup options.

4. Check the box opposite Turn on PDA
power when a program button is
pressed to enable the feature.
Pressing any one of the function
buttons on the front panel wakes up
the device.

5. Tap OK when done.

To change the Autorun settings:

1. Tap  , then tap Settings.

2. Tap the System tab, then tap the
System Settings icon.

3. Tap the Autorun tab to display the
options.

4. Tap either CF Card or SD Card from
which to start to automatically run an
application.

5. Tap OK when done.
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To change the USB Host settings:

1. Tap  , then tap Settings.

2. Tap the System tab, then tap the
System Settings icon.

3. Tap the USB Host tab to display the
options.

4. Enable or disable the USB host
feature by selecting the appropriate
box.

5. Tap OK when done.

Changing the memory settings

To change the memory allocation:

1. Tap  , then tap Settings.

2. Tap the System tab, then tap the
Memory icon to display the memory
allocation screen.

3. Drag the slider to change the memory
allocation for data storage and
program depending on your need.

4. Tap OK when done.
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To view the running programs:

1. Tap  , tap Settings, then tap the
System tab.

2. Tap the Memory icon, then tap the
Running Programs tab to display a
list of currently running programs.

3. If you wish to free some system
memory currently used by the running
programs, select a program then tap
Stop.

To stop all running programs, tap Stop
All.

To check the storage card memory:

1. Tap  , tap Settings, then tap the System tab.

2. Tap the Memory icon, then tap the Storage Card tab to display the
memory information for the selected storage card.

3. If you wish to free storage card memory, delete some files from the
storage card. Use the File Explorer to delete files. See page 2-13 for
information.
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Using simple applications
Your device includes several simple application that are useful in your day-
to-day use of your device.

NOTE The major applications that came with the Microsoft®

Windows Mobile® 2003 Second Edition are discussed in other
chapters.

To access the applications:

1. Tap  , then tap Programs.

2. Tap an icon to launch a specific
application program.

Calculator
Tap the Calculator icon to use basic
calculator functions.
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Games
Tap the Games icon to display the
available games.

Jawbreaker
The main objective of this game is to burst all jawbreakers. To do so, tap
two or more jawbreakers of the same color that are connected to each
other. The more jawbreakers you burst at a time, the higher your score.

NOTE For details on the game rules, see the Help information on
your device.

To play Jawbreaker:

1. Tap the Jawbreaker icon to display a
new game.

If you wish to reset the game, tap
Game, then tap New Game.
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2. Tap Game, then tap Options to
display the Options screen. Make your
desired changes, then tap OK to
return to the game.

3. Tap Info, then tap Statistics to:

- view your scores

- set the screen orientation

- reset your scores

4. Tap OK when done.
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Solitaire
The main objective of this game is to use all the cards in the deck to build
up four suit stacks in ascending order, beginning with the aces.

NOTE For details on the game rules, see the Help information on
your device.

To play Solitaire:

Tap the Solitaire icon to display a new
game. If you wish to reset the game, tap
New.

To change Solitaire options:

1. Tap Tools to display the game options. Make your desired changes.

2. Tap the Card Back tab to select a card design.

3. Tap OK when done.
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Pictures
Use Pictures to view .jpg pictures stored on your device or on a storage
card, send pictures to your friends, view a slideshow of your pictures, or
set a picture as background on the Today screen.

Refer also to the online help on your device for more information on using
this feature.

To use Pictures:

1. Tap  , then tap Programs.

2. Tap the Pictures icon to launch the
application.

3. Tap the thumbnail of the picture that
you wish to open.

4. When the picture appears on the
screen, use the menus and tools on
the command bar to edit your picture.
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5. Tap Tools, then tap Beam Picture if
you wish to send the picture to another
device with IR port.

or

Tap Send via E-mail... to attach the
picture to an e-mail.

or

Tap Set as Today Wallpaper... to use
the picture as your wallpaper in the
Today screen.

6. Tap Edit, then tap Brightness and
Contrast to adjust the lighting of
your picture to your desired effect.
Tap Done to apply your changes.

7. Use the Rotate tool to change the
picture orientation.
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8. Use the Crop tool to select a part of the picture and cut it.

9. Use the Zoom tool to enlarge the
picture.

10. Tap Tools, then tap Save Picture
As... to save your edited picture.
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Microsoft® ActiveSync®

What is ActiveSync®?
The Microsoft® ActiveSync® is one of the important bundled programs in
MyPal. With ActiveSync, you can synchronize the information on your
desktop computer with the information on your device. Synchronization
compares the data on your device with your desktop computer and
updates both computers with the most recent information.

For example:

• Keep Pocket Outlook data up-to-date by synchronizing your device with
Microsoft Outlook data on your desktop computer.

• Synchronize Microsoft Word and Microsoft Excel files between your
device and desktop computer. Your files are automatically converted to
the correct format.

NOTE By default, ActiveSync does not automatically synchronize all
types of information. Use the ActiveSync options to turn
synchronization on or off for specific information types.

With ActiveSync, you can also:

• Back up and restore your device data

• Copy (rather than synchronize) files between your device and desktop
computer

• Control when synchronization occurs by selecting a synchronization
mode. For example, you can synchronize continually while connected to
your desktop computer or only when you choose to synchronize.

• Select which information types are synchronized and control how much
data is synchronized. For example, you can choose to synchronize your
appointments of the past two weeks only, appointments older than two
weeks are not synchronized.

For more information about using ActiveSync:

1. Start ActiveSync on your desktop computer.

2. From the Activesync menu bar, click Help then on Microsoft
ActiveSync Help.
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Installing ActiveSync® on your computer
The ActiveSync program is already installed on your device. To
synchronize information on your device with your computer, you must also
install ActiveSync on your computer. Install ActiveSync from the
Companion CD that came with your product package.

NOTE Before starting the ActiveSync installation, make sure that
you have Microsoft® Outlook® installed on your computer. If
you do not have Outlook, install the Microsoft® Outlook® 2002
from the Companion CD. Even if you have Outlook 98 or
Outlook 2000 installed, you are encouraged to update to
Outlook 2002.

To install ActiveSync on your computer:

1. Turn on your computer and monitor.

IMPORTANT Do not connect your device to your computer until you
have finished installing ActiveSync.

3. Click on Start Here from the Main
Menu.

2. Place the Companion CD into the
optical drive of your computer. The
CD autoruns and displays the initial
screen, then the Main Menu from
which you can start the installation.
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4. Read the Overview before installing
ActiveSync 3.7.1 to make sure that
you perform the installation sequence
correctly.

5. If you have not installed Outlook,
install it now. Click Install Outlook
2002 and follow the screen
instructions to complete the
installation.

6. Click Download Connection Wizard
and read the overview to see if you
require the wizard. Follow the screen
instructions to install the wizard on
your computer. Return to the Main
Menu when done.

7. Click Install ActiveSync 3.7.1, then
click Install.

8. When prompted, select Run this
program from its current location then
click OK.

or

Click Open to launch the wizard that will
guide you through the installation .

9. Follow the instructions on the
succeeding screens.
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If you have previously installed
Microsoft® ActiveSync® in your
computer, the installation wizard
detects it and prompts you with a
message.

Click Next to continue installing and
replace the current version.

Click Cancel to quit and keep the
current version.

10. Wait until the wizard finishes copying all the
necessary files, and updates your system.

NOTE You may connect your Pocket PC to your computer right after
installing ActiveSync. Proceed to the section “Synchronizing
your device” on page 3-6 for instructions.
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Synchronizing your device

Connecting your device to a computer

To connect your device with the cradle:

1. Place the device on the cradle.

2. Connect the 26-pin device plug of the sync cable to the 26-pin
connector at the back of the cradle.

3. Connect the other end of the sync cable to a USB port on your
computer.

To connect your device without the cradle:

1. Connect the 26-pin device plug of the sync cable to the 26-pin
connector on the bottom of your device.

2. Connect the other end of the sync cable to a USB port on your
computer.

2
3

1 2

1

RESET

Pocket PC
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Setting up a partnership
Immediately after you have completed the installation, the New
Partnership wizard will start automatically to help you establish a
partnership and customize your synchronization settings. At this point, you
can decide exactly which types of information you would like to
synchronize with your computer.

A partnership is a file that allows you to synchronize your device
with your desktop computer. This file is stored on your desktop
computer. An additional file that enables your desktop computer to
recognize your device is stored on your device.

2. On the next screen, select
Synchronize with the desktop
computer. Click Next.

3. Select the type of information that
you wish to synchronize. Click
Next.

or

If you wish to customize a
synchronized item, highlight the
item then click Settings.

To set up a partnership:

1. When the New Partnership
screen appears, select Standard
partnership for the type of
partnership to establsih between
your device and your computer.
Click Next.
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On the Calendar
Synchronization Settings
window, for example, select from
the options how you wish to
synchronize the appointments on
your device with your computer.
Click OK.

4. Click Finish to complete setting a
partnership.

Immediately after you set up a
partnership, ActiveSync starts
automatically and initiates the first
synchronization between your
device and your computer.

Refer to the succeeding sections
for more details on
synchronization.
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Checking synchronized information
After your first synchronization, take a look at Calendar, Contacts, and
Tasks on your device. You will notice that the calendar information in
Microsoft Outlook on your computer was copied to your device, and the
information that you have on your device was copied to your computer.

NOTE Open Microsoft Outlook on your desktop computer to see the
details of copied information from your device.
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Manually initiating synchronization
Once you have set up ActiveSync and completed the first synchronization
process, you can initiate synchronization from your device at any time.

To manually initiate synchronization:

1. Tap  , Programs, then tap the ActiveSync icon to display the
ActiveSync screen.

2. To start synchronization, connect your device to your computer, then
tap Sync.

To end synchronization, tap Stop.

NOTE To synchronize via IR (infrared port) or to change
synchronization settings, stop synchronization with your
computer.

For more information on synchronization:

Tap  while in the ActiveSync screen, then tap Help.

Connection status
Tap to connect and synchronize
Tap to stop synchronization

Tap to synchronize via IR or
change synchronization settings
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Synchronization options
The Microsoft ActiveSync program allows you to customize your
synchronization settings at any time. You can select the items to
synchronize, set the synchronization schedule, and specify the
synchronization rules.

To display the synchronization options:

• From the ActiveSync window on your desktop computer, click on the
Options icon, or

• From the menu bar, click on Tools, then Options.

1. Check the box opposite the item
that you wish to synchronize.

2. Highlight a checked item then
click on Settings to specify
synchronization options for the
item.

For example, highlight Calendar
then click on Settings to display
the Calendar Synchronization
Settings window. Customize the
available settings, then click OK
when done.

3. Do the same for the other
checked items.

To select items to synchronize:

4. Click OK when done.

NOTE You cannot set the options
for unchecked items.
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To set synchronization schedule:

1. Click on the Schedule tab.

2. Select your desired
synchronization schedule.

3. Click OK when done.

To specify synchronization rules:

1. Click on the Rules tab.

2. Select your desired settings from
the available options.

3. Click OK when done.
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Installing other applications
The Companion CD packs a variety of useful applications. You may install
some of the applications directly from the CD and download other
available applications from the Internet.

To install applications from the Companion CD:

1. Place the Companion CD into the
optical drive of your computer.

2. From the Main Menu, click Enhance
Your Experience.

3. Read the Overview for the important
notes.

4. Click Mobility to display the available
items.

5. Click Pocket PC Applications to
display the mobility programs that you
can install on your device, then click
Details for installation instructions.

6. Click Entertainment to display the
available items.
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7. Click Pocket PC Applications to
display the entertainment programs
that you can install on your device,
then click Details for installation
instructions.

8. Click Desktop Applications to display
the entertainment programs that you
can install on your computer, then
click Details for installation
instructions.
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ASUS Camera
The ASUS Camera is a convenient interface program that allows you to
record videos with synchronized audio and capture digital images. Using
the integrated playback capability and photo editing feature, this program
makes creating simple videos and enhancing pictures right at your
fingertips!

To launch the ASUS Camera:

1. Tap  , then Programs.

2. Tap ASUS Programs, then ASUS
Camera to display the main screen.

ASUS Camera consists of four
applications:

• ASUS Camcorder

• Photo Viewer

• Photo Editor

• Photo Album

Specifications

Video • MPEG 4 Simple profile levels 0-3
• Single video object
• Video sizes:  CIF, QVGA, QQVGA, QQQVGA, QCIF
• File formats:  3gpp, AVI
• 128/256/384 kbps bit rate
• 15/25/max frame rate

Photo • Resolutions:  1280*960, 640*480, 352*288,
                      320*240, 176*144, 160*120,

   80*60 pixels
• File formats:  BMP, JPG

Audio • AMR speech encoding and decoding
• 4.7 kbps to 12.2 kbps bit rate
• 8 KHz sampling rate
• 16-bit mono
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ASUS Camcorder
Tap the ASUS Camcorder icon to launch the
application and record video with synchronized
audio clips or take still photo images. Use the
integrated playback function in the program to
watch your video, or launch the Photo Viewer or
Photo Album to display images.

The ASUS Camcorder has three modes: playback, recorder, and photo.
The default is playback mode.

Playback mode

Display area

In recorder mode, moves forward
to indicate recording in progress

Tap and slide right or left to
adjust the recording volume

Tap and slide right or left to
adjust the image brightness

Indicates the elapsed
recording time

Playback function buttons
(see descriptions below)

Indicates the camera status

Tap to display a list of media files

Tap to display settings screen for
playback/video image/photo image

Tap to display playback, video,
or photo statistics

Tap to display information on
ASUS Camera functions

Photo Viewer button
In playback mode (camera off), tap to
launch the Photo Viewer application

Photo Album button
In playback mode (camera off), tap to
launch the Photo Album application

Playback button
Tap to shift to either
recorder mode or photo mode

Play/pause button
Tap to play a media file;
while playing, tap to pause

Stop button
Tap to stop playing a media file

Rotate button
Tap to rotate the image 90 degrees
clockwise or counterclockwise
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Playback menus

To view the playlist:

1. Tap  on the command bar. A list of the available files appear.

2. Select a file that you wish to play by tapping on it.

To change the playback settings:

1. Tap  on the command bar to
display the options.

2. Make your desired changes.

3. Tap OK when done.
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To change the default folder for playlist:

1. Tap the down arrow on the Play List
Folder box to change the default
folder.

The contents of your folder appear
whenever you tap PlayList on the
command bar.

2. Tap OK when done.

To view playback information:

1. Tap  on the command bar.

2. Tap OK when done.

To view information about ASUS Camera:

1. Tap Help on the command bar.

2. Tap and hold the slider on the right
side of the screen to page down.

3. Tap OK to close the Help screen.
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Playback functions

To display an image or photo file:

1. While in Playback mode, tap the  (Photo Viewer) button to launch
the Photo Viewer application.

2. In the Photo Viewer main screen, tap
the Folder button to display a list of
available .jpg or .bmp files.

3. Tap on a file that you wish to display
from the list.

Tap the down arrow in the Folder box
to find files in other locations.

4. The file that you selected appears on
the photo viewer screen. Tap the
folder button again if you wish to
display other files.

NOTE Refer to section “Photo
Viewer” on page 4-19 for
more information on this
application, or to section
“Photo Editor” on page 4-23
on how to edit images.
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To play a video file:

1. While in Playback mode, tap the 
(Photo Album) button to display the
thumbnails of the available files in your
selected folder.

2. Select the file (.3gp or .avi file format)
that you wish to play by tapping its
thumbnail twice.

Tap Format on the command bar to
display and select other file formats.

3. While playing the video, tap the 
(Play/Pause) button to pause play.
Tap the button again to resume play.

4. After playing a video file, the screen
displays the thumbnails of available
files. Select another video file to play,

or tap  to exit Photo Album and
return to camera playback mode.

Thumbnail
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To change the display size of the video you are playing:

1. Tap on the video image to enlarge to
the size of display area.

3. From the full screen mode, keep tapping the image until it returns to
the default size.

2. Tap a second time to zoom to full screen. While in full screen mode,
tapping the image rotates it 45° counterclockwise.
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Recorder mode

Display area

In recorder mode, moves forward
to indicate recording in progress

Tap and slide right or left to
adjust the recording volume

Tap and slide right or left to
adjust the image brightness

Indicates the elapsed
recording time

Recorder function buttons
(see descriptions below)

Indicates the camera status

Tap to display a list of media files

Tap to display settings screen for
playback/video image/photo image

Tap to display playback, video,
or photo statistics

Tap to display information on
ASUS Camera functions

Tap to turn the camera flash on or off

Photo Viewer button
no function in this mode

Photo Album button
no function in this mode

Mode button-Recorder
Tap to shift to photo mode

Zoom button
Tap to change from 1X/2X/4X magnification

Play/Pause button
Tap to play a media file;
while playing, tap to pause

Stop button
Tap to stop recording

Record button
Tap to start recording
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Recorder menus

To view the playlist:

Tap   on the command bar. A list of
the available files from your default
folder appears.

If you have previously played video,

photo, or slideshow files, tapping the 
(Play) button launches the last file you
played.

To change the video image settings:

1. Tap  on the command bar to
display the video image options.

2. Make your desired changes.

Capture Mode - Auto, Incandescent,
Fluorescent, Twilight, Cloudy, Sunny,
Night

Special Effect - Normal, Portrait,
Scenes, Ancient, Black & White,
Negative Photo, Special Color-Blue,
Special Color-Red, Special Color-
Green

Tap and hold the slider for Contrast,
Brightness, and Shutter Volume to adjust to low or high.

Tap the Default button any time to revert to the default settings.

3. Tap OK when done.
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To change the auto shoot settings:

1. Tap  on the command bar, then
tap the Auto Shoot tab to display the
options.

2. Make your desired changes.

If you check the option Video
Automatically Save, the video files
you record are automatically saved to
your specified storage folder. Tap the
File Setting tab to set your storage
folder.

If you check the option Video Auto
Recording, the items Recording
Start After and Recording End After
become configurable. Tap the down
arrow opposite each item to set the
time in seconds.

3. Tap OK when done.
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To change the file settings:

1. Tap  on the command bar, then
tap the File Setting tab to display the
options.

2. Make your desired changes by tapping
the down arrow opposite each item.

Storage Folder - by default, your
video files will be saved in this folder.

Video Quality (KBPS) - High (384), Medium (256), Low (128)

Audio Quality (KBPS) - High (12.2), Medium (7.4), Low (5.15)

Resolution (Pixels) - 80*64, 160*128, 176*144, 320*240, 352*288

File Format - AVI, 3GPP

Capture Rate - Normal, High, Max

3. Tap OK when done.

NOTE If you wish to record a
longer video, specify a
storage folder in a CF card
or SD card.
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Recorder functions

To record video:

1. Tap the Mode button to shift to
Recorder mode.

Notice that the  (Playback) button

becomes  (Recorder) button, the

rotate button becomes  (Record)
button, and the camera status
indicator shows “CAMERA ON”.

2. Focus the camera lens (located at
the back of the device) to your
subject.

3. Tap the  (Record) button to start
recording your video.

4. Tap the  (Stop) button to end your
recording.

Camera status

Recorder mode button

Record button

If the lighting is not enough, tap Flash on
the command bar to turn on the camera
flash. The “Flash On” message briefly
appears on the status bar.

Flash options:

Flash Off - no flash

Flash On - flash is always on

NOTE Return to playback mode to play your recorded video. See
section “Playback mode” on page 4-3 on how to play the
video.
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To save the video:

1. After recording, a save window
appears. From the left window pane,
select and tap the folder where you
want to save the video file.

2. If desired, tap the media file name field
to change the video file name.

3. Tap and drag over the default file
name to highlight.

4. Tap the input panel icon to display the
soft keyboard.

5. Key-in the new name for the video file,
then press Save. The display returns
to the recorder mode.
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Photo mode

Display area

In recorder mode, moves forward
to indicate recording in progress

Tap and slide right or left to
adjust the recording volume

Tap and slide right or left to
adjust the image contrast
and brightness

Indicates the elapsed
recording time

Photo function buttons
(see descriptions below)

Indicates the camera status

Tap to display a list of media files

Tap to display settings screen for
playback/video image/photo image

Tap to display playback, video,
or photo statistics

Tap to display information on
ASUS Camera functions

Tap to turn the camera flash on or off

Photo Viewer button
no function in this mode

Photo Album button
no function in this mode

Photo button
Tap to shift to playback mode

Zoom button
Tap to change from 1X/2X/4X magnification

[Play/Pause button)
Tap to play a media file;
while playing, tap to pause

Stop button
Tap to stop recording

Record button
Tap to take a photo

NOTE When capturing photos, the ideal distance between the
camera and the subject is 60 cm to infinity.
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Photo menus

To view the playlist:

Tap  on the command bar. A list of
the available files from your default
folder appears.

To change the photo image settings:

1. Tap  on the command bar to
display the photo image options.

2. Make your desired changes.

Tap the Default button any time to
revert to the default settings.

3. Tap OK when done.
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To change the auto shoot settings:

1. Tap  on the command bar, then
tap the Auto Shoot tab to display the
options.

2. Make your desired changes.

3. Tap OK when done.

If you check the option Special
Capture, the items Continuously
Capture (selected by default) and
Photo Auto Capturing become
configurable.

If you select the item Photo Auto
Capturing, you can set the time
period (in seconds) for automatic
photo capturing. Tap the down arrow
to display the time options.

NOTE In Continuously Capture
mode, you can continuously
capture 72 photos.
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To change the file settings:

1. Tap  on the command bar, then
tap the File Setting tab to display the
options.

2. Make your desired changes by tapping
the down arrow opposite each item.

Storage Folder - by default, your
photo files will be saved in this folder

Resolution (Pixels) - 1280*960,
640*480, 352*288, 320*240, 176*144,
160*120, 80*60

Shutter Sound - Sound 1, 2, 3, 4

Frame - (None), Frame1 to Frame 15; see below for illustration

3. Tap OK when done.

To set a standard frame for your photos:

1. Tap  on the command bar, then
tap the File Setting tab to display the
options.

2. Tap the down arrow opposite the
Frame box to select and display other
frames.

If you do not wish to place your photos
in frames, select None.

3. Tap OK when done.

NOTE You may edit your photos to add frames and other effects
using the Photo Editor. See page 4-26 for more information
on editing photos.
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Photo functions

To take a picture:

1. Tap the Mode button to shift to
Photo mode.

Notice that the  (Recorder) button

becomes  (Photo) button, the

rotate button becomes  (Record)
button, and the camera status
indicator shows “CAMERA ON”.

2. Focus the camera lens (located at the
back of the device) to your subject.

3. Tap the  (Record) button to take a
picture.

Camera status

Photo mode button

Record button

If the lighting is not enough, tap Flash on
the command bar to turn on the camera
flash. The “Flash On” message briefly
appears on the status bar.

Flash options:

Flash Off - no flash

Flash On - flash is always on

Flash 0.5s - flash is on for 0.5 seconds

NOTE You can also turn the flash on or off by pressing the Launch
button of your device. See page 1-2 for the button location.



4-20 Chapter 4

Saving and viewing photos

To save photos:

By default, the ASUS Camera saves all captured photos in the My
Documents folder of the Pocket PC. A file name, which is a combination
of the date the photo was taken and a number sequence, is automatically
assigned to each photo.

To view the picture:

Return to playback mode to display the photo image that you took. See
section “Playback mode” on page 4-3 on how to display the image.
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Photo Viewer
Tap the Photo Viewer icon to launch the
application and view photo images in .jpg and
.bmp formats. You can display the images in
either panning or full screen, and rotate them as
you wish. This program also allows you to create
a slide show composed of several .jpg files and
displayed at continuously at intervals (in seconds)
that you specified.

Display area

Tap to exit photo viewerDisplays a thumbnail of the selected file

Tap to display an image
in landscape orientation

Tap to display file locations

Tap to display an image
in portrait orientation

Tap to create a slideshow
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Photo Viewer functions

To open a file:

1. Tap the  (Folder) button to display a list of image files.

2. Tap the image file (.jpg or .bmp format) that you wish to open.

3. Tap the  again to open another file, or the  (Exit) button to close
the Photo Viewer application.

To find files in another location:

1. Tap the down arrow opposite the
Folder box to display a list of existing
folders.

2. Tap the name of a folder to display a
new list of files.
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To create a slideshow:

1. Tap the  (Slideshow) button to
display the available files that you can
use.

2. Tap the files (.jpg and .bmp formats)
that you wish to combine into a
slideshow. The files that you selected
appear on the right column.

3. Tap the  (Save) button to save the
slideshow file (.lst format).

To display specific types of files:

1. Tap the down arrow opposite the Type
box to display a list of file types.

2. Tap the file type to display a new list of
files.

4. Tap the   (Slide interval) button to
specify the time interval for slide
transition. The number on the button
indicates the interval in seconds. Keep
tapping the button to select from 1
second to 10 seconds.
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6. A message appears indicating that
your slideshow file is saved. Tap OK.

5. Tap the  (Landscape) button or the  (Portrait) button to specify
the orientation of the images in your slideshow. Tapping any of the
buttons shows a preview of your selected image files in either
landscape or portrait orientation.

Landscape orientation Portrait orientation
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Photo Editor
Tap the Photo Editor icon to launch the
application and customize images to your
preference. You can add special effects like
blurring, sepia, negative, neon, and even place
photots in a frame. You can even add text or
caption to the image to make it more descriptive.

The initial screen of the photo editor application does not show any
specific file. The screen appears as shown.

NOTE If no image is displayed on the screen, the editing buttons are

grayed out and and not selectable. Only the  (Exit)
buttons are activated.

Tap to display the File menu

Tap to display the Tools menu

Display area

Editing buttons

Tap to display the zoom options
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Photo Editor functions

To open and edit a file:

1. Tap File, then Open to display your
default folder and file type.

If you wish to find files from other
folders, tap the down arrow opposite
the Folder box to display your folder
selection, then tap your desired folder.

If you wish to display only a certain
type of file, tap the down arrow
opposite the Type box to display your
file selection, then tap a file type. A
new list of files then appears.

Advanced toolbar

Basic toolbar

Thumbnails

2. Tap the file that you wish to open and edit.

By default, the screen displays the image file that you selected, three
thumbnails of other image files, activated editing buttons on the
toolbars, command bar, and the zoom options box.

NOTE If you wish to open another image, simply tap any of the
image thumbnails. Tap and hold the slider, or tap left/right
arrows to display other thumbnails.
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3. To change the file view size, tap the zoom options box, then select
your desired magnification. The file appears in the size you specified.

4. To remove the thumbnails of other files and view your selected file
100%, tap Tools from the command bar then tap (uncheck) the
Thumbnail View item.
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6. Tap your desired frame twice to
automatically place your image in it.

7. Tap the Frame button to exit frame
editing mode, and re-activate other
editing buttons and command bar
menus.

8. Tap other editing buttons to add more
effects to your image.

NOTE You need to exit one editing
mode before you can go to
another mode or use the
command bar menus.

9. Tap File, then tap Save.

10. Key-in a name, then specify a folder,
type, and location for your
customized file. Tap OK.

11. When prompted, specify the size for
your file. Tap OK.

5. Tap the Frame button to display the
available frames that you can use.
Use the slider or the left/right arrows
to see other frames.
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Photo Album
Tap the Photo Album icon to launch the
application and display the available media files
(.3gpp, .avi, .jpg, .bmp) represented in small
thumbnails.

To find files from other locations:

1. Tap the down arrow in the Folder box
to display the folders on your device.

2. Select the folder where you wish to
locate files. A new group of thumbnails
appear on the screen.

Tap to display the supported file formats

Tap to display sort options

Tap a thumbnail twice to
open or play
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ASUS Launcher
This program allows you the convenience of classifying your frequently
used programs, and quickly launching them with just a few taps.

Accessing ASUS Launcher

To access ASUS Launcher:

1. Tap  , then Programs.

2. Tap ASUS Programs, then ASUS Launcher.

NOTE To quickly access ASUS Launcher, press the  button
(leftmost) on your device.

3. From the command bar, tap
Name to display the names of the
existing categories.

The default categories are
Favorites, Start Menu, and
Programs.

4. Tap a category to display the
programs it contains.

By default, the Favorites category
contains the ASUS Launcher and
ASUS Backup program icons.
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5. Tap Start Menu or Programs to display the default programs in them.

NOTE Whatever category is selected, that category will be launched
the next time you tap the ASUS Launcher icon.
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Changing the name of a default category

To edit the name of a default category:

1. Tap Name, and select a category that you wish to rename. For
example, Programs.

2. Tap Category, then Edit Title.

3. In the Edit Current Category screen, revise the name.

4. Tap OK.

NOTE You cannot delete the default categories. However, you may
edit the default titles, and add or delete programs contained
in these categories.
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Customizing an existing category

To customize an existing category:

1. Tap Editor, then Copy To.

2. Tap Name, then tap the category
where you wish to copy the program
icon, e.g. Programs or Start Menu.

3. In the Programs (or  Start Menu)
screen, tap the program icon that you
wish to copy. For example,
Jawbreaker. A pop-up screen
appears.

4. Select a target destination for the
program icon. For example, Favorites.

5. Repeat steps 3 and 4 to copy other
programs that you wish to launch often.

6. When done, tap Copy To then Launch to return to the launch mode.

NOTE The option Copy To copies the program icon to your
specified destination but still keeps it in the original category.
If you do not wish to have duplicate icons, use the option
Move To.

7. Tap Name then Favorites to display
your customized quick launch
programs.

8. Tap OK to set Favorites as your quick
launch category.

The next time you access ASUS
Launcher, the Favorites category
appears.
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Removing programs in a category

To remove programs from a category:

1. Tap Editor, then Remove.

2. Tap Name, then any of the
existing categories.

3. Tap the program icon that you
wish to remove. For example, the
Calculator icon in the Favorites
screen.

The icon disappears from the
screen as soon as you tap it.

4. When done, tap Remove then
Launch to return to the launch
mode.

5. Tap OK to save your changes.

Adding a category

To add a new category:

1. Tap Category, then Add. A new
category is automatically added.

2. Tap Name to see the updated list
of categories.

3. If you wish to rename the new
category, see page 4-30 for
instructions.
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To stop all running programs:

1. Tap  , then tap Settings.

2. Tap the System tab, then tap the
Memory icon.

3. On the Memory screen, tap the
Running Programs tab.

4. Tap the Stop All button, then tap OK.

ASUS Backup
The ASUS Backup utility lets you back up your system files and/or data
contained in the main system memory. Unlike the ASUS SmartKeeper
automatic backup feature that backs up the entire system status (system
and data) into one backup file, this utility allows you to manually create
separate backup files for your system files and data files. You may even
categorize the data files and place them into different folders.

Accessing ASUS backup

To access the ASUS backup utility:

1. Tap  , then tap Programs.

2. Tap ASUS Programs, then tap ASUS
Backup.

A message appears asking you to stop
other programs before running the
backup utility.

3. Tap OK and stop all running programs.
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Backing up all data

To back up all data on your device:

1. Return to the ASUS programs screen
and tap the ASUS Backup icon.

2. Tap the Backup tab on the ASUS
Backup screen.

3. Tap All Data button to back up all data
on your device.

4. In the Backup File screen:

• specify a file name for the backup

• specify the folder in which to store
the backup file (optional)

• select the storage device (Flash
Disk , SD Card, or CF card) where
you wish to save your backup file

5. Tap OK to start the backup process.

NOTE You need to insert a CF memory card or an SD card if you
wish to save your backup file into a removable storage
device; otherwise, you can save the backup file into the Flash
Disk.

NOTE See the online help on your device for online instructions to
back up or restore data.
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6. The screen shows the status of the backup process. When done, a
message appears indicating that the backup is complete, and shows
the total size of the backed up files.

In case the program fails to back up any items, it will show the items on
the screen.

7. Tap OK.

Backing up PIM data

To back up only PIM data on your device:

1. On the ASUS Backup screen, tap PIM
Data button to back up only the
personal information management
(PIM) data on your device.

2. Select the storage device (Flash Disk,
SD Card, or CF card) where you wish
to save your backup file.

Tapping Cancel returns you to the
previous screen.

3. Tap the Backup tab.
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If you checked the box User Defined
Folders, tap Define to specify the
folders that you wish to include in the
backup file, then tap OK.

6. Tap Start to begin the backup
process.

7. When the backup process is complete,
the screen displays the message
“Complete” and a list of all the backed
up items.

8. Tap OK.

4. Type a name for your backup file and
the folder where you wish to place it.
You may opt not to specify a folder.

5. Check the boxes opposite the items
that you wish to back up, or tap Select
All to select all listed items.
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Restoring all data

To restore all data:

1. Tap  , then tap Programs.

NOTE If you saved your backup file into an SD card or CF card, you
need to insert that SD card or CF card into the SD/CF slot
when restoring data. Otherwise, you will receive the message
“No storage devices are found!”

2. On the ASUS Programs screen, tap
the ASUS Backup icon.

When prompted, stop all running
programs. See page 4-33 for
instructions.

3. Tap the Restore tab on the ASUS
Backup screen.

4. Tap All Data.

5. In the Backup File screen:

• select the backup file name  (tap
the arrow to list down other backup
files, if any)

• select the folder that contains your
backup file (optional)

• select the storage device (Flash
Disk, SD card, or CF card) where
you stored your backup file

6. Tap OK to start the restore process.

7. When the restoration is done, a
message appears prompting you to
manually reset the device.

8. Tap OK to reset.
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Restoring PIM data

To restore PIM data:

1. On the ASUS Backup screen, tap
PIM Data.

2. When prompted, select the storage
device (Flash Disk, SD card, or CF
card) where you stored your backup
file.

Tapping Cancel returns you to the
previous screen.

3. Tap the Restore tab.

4. Select the backup file name  (tap the
arrow to list down other backup files,
if any).

5. Check the boxes opposite the items
that you wish to restore, or tap
Select All to select all listed items.

If you checked the box User Defined
Folders, tap Define to specify the
folders that you wish to restore, then
tap OK.

6. Tap Start to begin the restore
process.

7. When the restoration is done, a
message appears prompting you to
manually reset the device.

8. Tap OK to reset.
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ASUS SmartKeeper
The ASUS SmartKeeper is an automatic backup feature that prompts you
to backup the current system status in a CF card or SD card whenever the
remaining battery power reaches a certain level. With the automatic
option, the backup process is done whether the device is ON or OFF as
long as a CF card, or an SD card, is present in its slot.

Automatic backup

Requirements for automatic backup
• SmartKeeper is enabled

• a CF card or SD card in the card slot (64MB free space recommended)

• the remaining battery power in the device reaches a low level

Enabling automatic backup

To enable automatic backup:

1. Tap  , then tap Settings.

2. Tap the System tab on the bottom of the Settings screen.

3. Tap the SmartKeeper icon to launch SmartKeeper.

4. Select the available storage device (SD card or CF card) to use for
backup, then tap Apply.

5. Tap the Automatic tab.
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6. In the Automatic screen, check the
Automatic system backup box to
enable automatic backup. This box is
checked by default.

When SmartKeeper is set to
Automatic, make sure that a CF card
or an SD card (64MB free space
recommended) is present in the
respective slot.

7. Tap OK.

NOTE To verify if the CF card, or the SD card, is usable for system
backup, perform a Manual backup first. See the section “To
use manual backup” on page 4-44.

How automatic backup works
SmartKeeper is capable of performing the automatic backup process
whether your device is in use (ON) or in suspension (OFF).

When the device is ON
If a low battery status occurs while you are using the device, this message
appears, “Battery low! Back up the current system status?”

Backing up the “current system status” means that the entire
system and all the data in the system main memory are saved as
is to the ASUSBKUP.SAV file. For example, you are editing an
Excel file when a battery low status occurs and you confirmed to
back up. When you restore the system status from the
ASUSBKUP.SAV file, you will see exactly the same screen,
settings, and system configuration as earlier backed up.
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To back up the current system status:

When prompted, tap the Yes button on
the screen message window to start the
backup process.

Tap No if you do not wish to back up the
system status at this time.

A confirmation message appears when
the backup process is complete.

NOTE Make sure that either a CF card or an SD card is in the
respective slot. If you tap Yes without any card, an error
message appears, indicating that your selected backup
destination is not ready.
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When the device is OFF
Whenever a low battery status occurs while the device is in standby or
OFF mode:

1. SmartKeeper wakes up the system to back up the system status.

2. SmartKeeper checks if a CF card or an SD card is ready in the slot.

3. If found, SmartKeeper backs up the current system status to
ASUSBKUP.SAV file in the CF card or SD card. When the backup
process is complete, the system automatically goes back to sleep
(OFF).

NOTE If no card is found, the device goes back to sleep without
performing the backup process.

When you turn on the device, either one of the following messages is
flashed on the screen.

If automatic backup is successfulThe system detected a battery
power low status. The system
status was automatically backed
up to ASUSBKUP.SAV file in the
CF card (or SD card).

If automatic backup failed because
a CF card/SD card, is not ready in
the slot

The system detected a battery
power low status and tried to
back up the system status at
2004/06/14, 10:21:27 AM. Backup
failed! Cannot access CF card (or
SD card).

If automatic backup failed because
the CF card/SD card in the slot
may be defective and not
accessible

The system detected a battery
power low status and tried to
back up the system status at
2004/06/14, 10:21:27 AM. Backup
failed! CF card (or SD card) not
ready.
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The system detected a battery
power low status and tried to
back up the system status at
2004/06/14, 10:21:27 AM. Backup
failed! System error.

If automatic backup failed because
a system error occurred

The system detected a battery
power low status and tried to
back up the system status at
2004/06/14, 10:21:27 AM. Backup
failed! Insufficient space in the
CF card (or SD card).

If automatic backup failed because
the available space in the CF card/
SD card is not enough to back up
the current system status
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Manual backup

To use manual backup:

1. Tap  , then tap Settings.

2. Tap the System tab on the bottom of
the Settings screen.

3. Tap the SmartKeeper icon, then the
Manual tab.

4. Tap the Back up system button to
back up the current system status to
the CF card or SD card.

A message appears to confirm that the
backup process is complete.

NOTE While backing up, the screen blacks out and shows the
message “Backup in progress” and the percentage of
backed up data.

If a CF card or an SD card is not
present, an error message appears
after you tap the back up button.
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The screen displays the backup file
information after the backup process.
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Manual restore

To restore the system status:

1. Tap  , then tap Settings.

2. Tap the System tab on the bottom of the Settings screen.

3. Tap the SmartKeeper icon, then the Manual tab.

4. Tap the Restore system button to restore the saved system status
from the CF card or SD card.

During the Restore process, the screen
blacks out and displays only the following
details:

• file date

• file time

• percentage of restored data

File Date:  2004/06/15
File Time:  09:27/48 PM
Restore in progress:  %

NOTE The Owner Information screen appears after the restore
process is complete. Tap the screen to return to the previous
status before you initiated the restore process.
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Introduction
Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Notes, and
Messaging. You can use these programs individually or together. For
example, you can use an e-mail address stored in Contacts to address
e-mail messages in Messaging.

Using ActiveSync®, you can synchronize information in Microsoft Outlook
or Microsoft Exchange on your desktop computer with your device. You
can also synchronize this information directly with a Microsoft Exchange
server. Each time you synchronize, ActiveSync compares the changes you
mode on your device and desktop computer or server and updates both
computers with the latest information. For information on using ActiveSync,
see ActiveSync Help on your desktop computer.

You can switch to any of the Pocket Outlook programs by tapping .

Calendar
Use Calendar to schedule appointments, including meetings and other
events. You can check your appointments in one of several views
(Agenda, Day, Week, Month, and Year) and easily switch views using the
View menu.

NOTE You can customize the Calendar display, such as changing
the first day of the week, by tapping Options on the Tools
menu.

Tap to go to Today

Tap to display or edit the
appointment details

Tap to create a new appointment
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Creating appointments

To create an appointment:

1. If you are in Day or Week view, tap your desired date for the
appointment,

2. Tap New.

3. Using the input panel, enter a description and a location. Tap to select
the field.

4. If needed, tap the date and time to change them.

5. Enter other desired information. You will need to hide the input panel to
see all available fields.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see the section
“Notes” later in this chapter.

7. When done, tap OK to return to Calendar.

Tap to select from a predefined text
Tap to select from previously
entered locations
Tap to specify the time of appointment
Tap to specify the date of appointment

Tap to add notes to the appointment

NOTE If you select Remind me in an appointment, your device will

remind you according to the options set in , Settings,
Personal tab, Sounds & Notifications.
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Using the summary screen
When you tap an appointment in Calendar, a summary screen appears. To
change the appointment, tap Edit.

Creating meeting requests
You can use Calendar to set up meetings with users of Outlook and
Pocket Outlook. The meeting request will be created automatically and
sent either when you synchronize Inbox or when you connect to your
e-mail server.

To create a meeting request:

1. Tap Tools then Options to indicate how you want meeting requests
sent.

2. If you send and receive e-mail messages through ActiveSync, select
ActiveSync.

To schedule a meeting:

1. Create an appointment.

2. In the appointment details, hide the input panel, then tap Attendees.

3. From the list of e-mail addresses you have entered in Contacts, select
the meeting attendees.

The meeting notice is created automatically and placed in the Outbox
folder. For more information on sending and receiving meeting
requests, see Calendar and Messaging online help on the device.

Appointment details

Notes/additional information
on the appointment

Tap to change details of the appointment
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Contacts
Contacts maintains a list of your friends and colleagues so that you can
easily find the information you look for, whether you are at home or on the
road. Using the infrared port (IR) on the device, you can quickly share
Contacts information with other device users.

NOTE To change the way information is displayed in the list, tap
Tools then Options.

Tap and enter part of a name
to quickly find it on the list

Tap to select the category of
contacts you want to display

Tap to display additional phone
numbers and email addresses

Tap to display or edit the contact details

Tap to create a new contact

Tap to sort contacts by name or company

Tap an action for a selected contact
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Creating contacts

To create a contact:

1. Tap  , then tap Contacts.

2. Tap New to display a blank
contact form.

3. Using the input panel, enter a
name and other contact
information. You will need to scroll
down to see all available fields.

4. To assign the contact a category,
scroll to and tap Categories, then
select a category from the list. On
the contact list, you can display
the contacts by category.

Using the summary screen
Tapping a contact on the contact list displays a summary screen. To
change the contact information, tap Edit.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see the section
“Notes” later in this chapter.

6. Tap OK to return to the contact list when done.

Contact details

Tap to display notes

Tap to change contact information
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Finding a contact
There are four ways to find a contact.

1. In the contact list, enter a contact
name in the box under the
navigation bar. To show all contacts
again, clear text from the box or tap
the button to the right of the box.

2. In the contact list, tap the category
list (labeled All Contacts by
default) and select the type of
contact that you wish to display. To
show all contacts again, select All
Contacts. To view a contact not
assigned to a category, select
None.

3. To view the names of companies
your contacts work for, in the
contact list, tap View > By
Company. The number of contacts
that work for that company will be
displayed to the right of the
company name.

4. Tap  > Help, then tap Find.
Enter the contact name, select
Contacts for the type, and tap Go.

1

2

3

4



5-8 Chapter 5

Tasks
Use Tasks to keep track of what you have to do.

Creating tasks

To create a task:

1. Tap  , then tap Tasks.

2. Tap New to display a blank task
form.

3. Using the input panel, enter a
description.

4. Enter a start date and due date,
or enter other information by
tapping the field first. If the input
panel is open, you will need to
hide it to see all available fields.

Tap to select a sort
order of the task list

Tap to select the category of
tasks you want to display

Indicates high priority

Tap to display or edit
the task details

Tap and hold to display a
pop-up menu of actions

Tap an action for the task

Tap to create a new task
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5. To assign the task to a category, tap Categories and select a category
from the list. On the task list, you can display tasks by category.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see the section
“Notes” later in this chapter.

7. Tap OK to return to the task list when done.

Using the summary screen
Tapping a task on the task list displays a summary screen. To change the
task details, tap Edit.

TIP To quickly create a task with
only a subject, tap Entry Bar on
the Tools menu. Tap Tap here
to add a new task and enter
your task information.

Task details

Tap to show or hide the task details

Notes/additional information on the task

Tap to change the task details
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Notes
Quickly capture thoughts, reminders, ideas, and phone numbers with
Notes. You can create a written note or a recording. You can also include a
recording in a note. If a note is open when you create the recording, it will
be included in the note as an icon. If the note is displayed, it will be
created as a standalone recording.

You may change the default Notes options including the writing mode,
template, file storage, and record button action.

To change the Notes options:

1. Tap  , tap Programs, then tap
Notes.

2. Tap Tools, then Options... to
display the options screen.

3. Make your desired changes.

4. Click OK.

Tap to change the sort order of the list

Tap to open a note or play a recording

Tap to record

Tap to show or hide the recording toolbar

Tap to create a new note or recording

Tap and hold to display a
pop-up menu of actions

Tap an action for the item
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Creating notes

To create a note:

1. Tap  , then tap Notes.

2. Tap New to display a blank note.

3. Create your note by writing, drawing, typing, or recording. For more
information about using the input panel, writing and drawing on the
screen, and creating recordings, see Chapter 2.

Tap to show or hide
the input panel

Tap to save the note and
return to the Notes list

Tap to write on the screen

Tap to add a recording to the note
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Messaging
Use Messaging to send and receive e-mail messages in one of these
ways:

• Synchronize e-mail messages with Microsoft Exchange or Microsoft
Outlook on your desktop computer

• Send and receive e-mail messages by connecting directly to an e-mail
server through an Internet service provider (ISP) or a network

Synchronizing e-mail messages
You can e-mail messages as part of the general synchronization process.
You will need to enable mail synchronization in ActiveSync. For more
information on enabling mail synchronization, see the ActiveSync online
help on your desktop computer.

During synchronization:

• Messages are copied from the mail folders of Exchange or Outlook on
your desktop computer to the ActiveSync folder in Inbox on your device.
By default, you will receive messages from the past five days only and
the first 100 lines of each message.

• E-mail messages in the Outbox folder on your device are transferred to
Exchange or Outlook, then send from those programs.

• E-mail messages in subfolder must be selected in ActiveSync on your
desktop computer in order to be transferred.

NOTE You can also synchronize e-mail messages with your desktop
computer from a remote location. For more information on
connecting your device, see Chapter 8.
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Connecting directly to an e-mail server
In addition to synchronizing e-mail messages with your desktop computer,
you can send and receive e-mail messages by connecting to an e-mail
server using a modem or network card connected to your device. You
need to set up a remote connection to a network or an ISP, and a
connection to your e-mail server. For more information, see Chapter 8.

When you connect to the e-mail server, new messages are downloaded to
the device Inbox folder, messages in the device Outbox folders are sent,
and messages that have been deleted on the e-mail server are removed
from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your
e-mail server rather than your desktop computer. When you delete a
message on your device, it is also deleted from the e-mail server the next
time you connect based on the settings you selected in ActiveSync.

You can work online or offline. When working online, you read and
respond to messages while connected to the e-mail server. Messages are
sent as soon as you tap Send, which saves space in your device.

When working offline, once you have downloaded new message headers
or partial messages, you can disconnect from the e-mail server and decide
which messages to download completely. The next time you connect,
Inbox downloads the complete messages you have marked for retrieval
and sends the messages you have composed.
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When you connect to your e-mail server or synchronize with your desktop
computer, by default, you will receive messages from the last five days
only, the first 100 lines of each new messages, and file attachments of less
than 100KB in size. The original messages remain on the e-mail server or
your desktop computer.

You can mark the messages that you want to retrieve in full during your
next synchronization or e-mail server connection. In the message list, tap
and hold the message that you want to retrieve. On the pop-up menu, tap
Mark for Download. The icons in the Inbox message list give you visual
indications of message status.

You can specify your downloading preferences when you set up the
service or select your synchronization options. You can change them at
any time.

• Change options for Inbox synchronization using ActiveSync options. For
more information, see ActiveSync Help on your desktop computer.

• Change options for direct e-mail server connections in Inbox on your
device. Tap Tools then Options. On the Service tab, tap the service that
you wish to change. Tap and hold the service and select Delete to
remove a service.



Microsoft® Pocket Outlook 5-15

Reading messages in Inbox
The messages you receive appear in your Inbox folder. By default, the
most recently received messages appear on top of the list. Unread
messages appear in boldface.

Tap an e-mail message from your Inbox to display it.

Tap to select the sort order
for the messages

Tap and hold to display a
pop-up menu of actions

Tap to connect, and to send/receive e-mail

Tap to connect to the selected service

Tap to select the service, and the
folder that you wish to display

Tap to return to the message list

Tap to delete this message

Tap to reply to or forward this message

Tap to view the next message

Tap to view the previous message
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Composing messages

To compose a message:

1. Tap New to display a blank e-mail screen.

Tap to show or hide the
complete message header

Tap to send the message

Tap to select a preset message
Tap to display the e-mail address book

Tap to show or hide the recording toolbar

Enter the e-mail address here

Type your text here

2. In the To field, enter the e-mail address of your recipient. You may
either type the e-mail address or select a name from the Contacts list
by tapping the Address Book button.

If you wish to send a copy of your
e-mail to other recipients, tap the
down arrow on the corner of the
addressing area to display the Cc:
and Bcc: lines in the message header.

The addresses in the To: and Cc: can
be viewed by all recipients.

The addresses in the Bcc: are hidden
from the recipients.
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3. Compose your message.

To address your e-mail to several
recipients, type the e-mail addresses
separated by a semicolon. A
semicolon is automatically added
between e-mail addresses if you
select from your Contacts list.

All the names in the Contacts list with
e-mail addresses appear in the e-mail
address book.

4. Tap Send when you have finished the message.
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Using preset messages
To enter preset or frequently used
messages, tap My Text from the
command bar and select your desired
message.

Editing or adding preset messages

To edit or add preset messages:

1. Tap Tools from the command bar to
display the menu.

2. Tap Edit My Text... to display a list of
preset messages.

3. Select a message to change.

or

Select a blank line from the bottom of
the list, then type your customized
message.

4. Tap OK when done.
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Saving composed messages
If you are working offline, the message is
moved to the Outbox folder and will be
sent the next time you connect.

If you do not wish to send the message
immediately, tap OK after composing the
message to save it to the Drafts folder.

When you are ready to send the
message, open the Drafts folder and tap
the message. Tap Send to send the
message.
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Managing e-mail messages and folders
The behavior of the folders you create depends on whether you are using
ActiveSync, SMS, POP3, or IMAP4.

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will
automatically be sunchronized with your device. You can select to
synchronize additional folders by designating them for ActiveSync. The
folders you create and the messages you move will then be mirrored on
the server. For example, if you move two messages from the Inbox folder
to a folder named Family, and you have designated Family for
synchronization, the server creates a copy of the Family folder and
copies the messages into that folder. You can then read messages while
away from your desktop computer.

• If you use SMS, messages are stored in the Inbox folder.

• If you use POP3 and you move e-mail messages to a folder you created,
the link is broken between the messages on the device and their copies
on the mail server. The next time you connect, the mail server will see
that the messages are missing from the device Inbox and delete them
from the server. This prevents you from having duplicate copies of a
message, but it also means that you will no longer have access to
messages that you move to folders created from anywhere except the
device.

• If you use IMAP4, the folders you create and the e-mail messages you
move are mirrored on the server. Therefore, messages are available to
you anytime you connect to your mail server, whether it is from your
device or desktop computer. This synchronization of folders occurs
whenever you connect to your mail server, create new folders, or
rename/delete folders when connected.
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The companion programs consist of Microsoft® Pocket Word, Microsoft®

Pocket Excel, MSN Messenger, and Windows Media™ Player for Pocket
PC.

To switch to a companion program on your device, tap Programs on the
 menu, then tap the program that you wish to open.

Pocket Word
Pocket Word works with Microsoft Word on your desktop computer to give
you easy access to copies of your documents. You can create new
documents on your device, or you can copy documents from your desktop
computer to your device. Synchronize documents between your desktop
computer and your device so that you have the most up-to-date content in
both locations.

Use Pocket Word to create documents, such as letters, meeting minutes,
or trip reports.

1. Tap  , tap Programs, tap
Pocket Word to launch the
application.

If you have existing Microsoft
Word or Pocket Word documents
in your device, a list of the
documents appears.

Creating Pocket Word documents

To create a new Word document:

NOTE If you selected a template for new documents in the Options
dialog box, that template appears with the appropriate text
and formatting already provided.
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2. Tap New to display a blank document.

3. Use any of the tools in the input panel to type your text.

Saving Pocket Word documents

To save a Pocket Word document:

When you have finished editing your document, tap OK.

The document is saved using the first line as file name if you did not
specify a file name. For example, if your first line in the document has the
words Bits-n-Pieces, these words appear in your Word documents list.

Type your text here

Tap to select an input method

Tap to show or hide the input panel

Tap to show or hide the formatting toolbar

Tap to save and close your document

Formatting toolbar
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To specify save options:

1. With the document open, tap
Tools.

2. From the pop-up menu, tap File,
then tap Save Document As... to
display the Save As screen.

3. Change the file name by simply
typing a new one in the Name
field.

4. Tap the down arrow in the Folder
field to select a folder where you
wish to place the file.

NOTE If you do not wish to change the document format, but would
like to change the file name, folder, and location of your
document, tap Tools then tap File from the command bar.
Tap Rename/Move... from the pop-up menu to make your
changes.

5. Tap the down arrow in the Type field to select a file format.

6. Tap the down arrow in the Location field to indicate the location of
your saved file, either in the main memory of your device, or in a
storage card, if available.

7. Tap OK when done.
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Opening an existing Pocket Word document
Pocket Word contains a list of the files stored on your device. Tap a file in
the list to open. To delete, make copies of, and send files, tap and hold a
file in the list, then select the appropriate action on the pop-up menu.

NOTE You can open only one Pocket Word document at a time;
when you open a second document, you will be asked to
save the first.

Tap to select the folder you want to display

Tap to change the sort order of the list

Tap to open a document

Tap to create a new document

Tap to change document settings
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Modes of entering information
You can enter information in Pocket Word in one of four modes (typing,
writing, drawing, or recording), which are displayed on the View menu.
Each mode has its own toolbar that you can show or hide by tapping the
Show/Hide Toolbar button on the command bar.

If you are opening a Word document created on a desktop computer,
select Wrap to Window on the View menu so that you can see the entire
document.

To change the zoom option:

1. Tap View, then tap Zoom.

2. Select your desired percentage.

Select a higher percentage to enter text and lower one to see more of
your document.

Typing Mode
Using the input panel, enter typed text into the document. For more
information on entering typed text, see Chapter 2.

To format existing text and to edit text, first select the text. You can select
text as you do in a Word document, using your stylus instead of the mouse
to drag through the text you want to select. You can search a document to
find text by tapping Edit and Find/Replace.
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Writing mode
In writing mode, use your stylus to write directly on the screen. Ruled lines
are displayed as a guide, and the zoom magnification is greater than in
typing mode to allow you to write more easily. For more information on
writing and selecting writing, see Chapter 2.

NOTE If you cross over three ruled lines with a single stroke, the
writing becomes a drawing that you can edit as described in
the next section.

Written words are converted to graphics (metafiles) when a
Pocket Word document is converted to a Word document on
your desktop computer.

Write your text here

With the Space button selected,
drag to insert space. An arrow
appears showing the space
direction direction and size.

Tap to show or hide the writing/formatting toolbarPen button

Space button

Tap to display the menu

Tap to display zoom percentages

Tap to wrap text to screen
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Drawing mode
In drawing mode, use your stylus to draw on the screen. Gridlines appear
as guides. When you lift your stylus off the screen after ther first stroke,
you will see a drawing box indicating the boundaries of the drawing. Every
subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see
Chapter 2.

Recording mode
In recording mode, embed a
recording into your document.
Recordings are saved as .wav files.
For more information on recording,
see Chapter 2.

Resize an object by dragging
the selection handles

Tap an arrow to display the options
Pen button

Drawing toolbar

Tap to show or hide the drawing toolbar

Tap to select the formatting options

Embedded recording
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Pocket Excel
Pocket Excel works with Microsoft Excel on your desktop computer to give
you easy access to copies of your workbooks. You can create new
workbooks on your device, or you can copy workbooks from your desktop
computer to your device. Synchronize workbooks between your desktop
computer and your device so that you have the most up-to-date contents
in both locations.

Use Pocket Excel to create workbooks, such as expense reports and
mileage logs.

Pocket Excel contains a list of the files stored on your device. Tap a file in
the list to open. To delete, make copies of, and send files, tap and hold a
file in the list, then select the appropriate action on the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas,
functions, sorting, and filtering. To display the toolbar, tap View, then tap
Toolbar.

NOTE You can open only one Pocket Excel document at a time;
when you open a second document, you will be asked to
save the first.

Cell contents appear here as you
type, or when you select the cell

Zoom button

Format button

AutoSum button
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Creating a Pocket Excel document

To create a new Excel document:

1. Tap  , tap Programs, tap Pocket
Excel.

2. Tap New to display a blank document.

If you selected a template for new
documents in the Options dialog box,
that template appears with the
appropriate text and formatting already
provided.



Companion programs 6-11

Saving a Pocket Excel document

To save an Excel document:

When you have finished editing your document, tap OK.

By default, your document is saved as Book1 as file name. You can
change the file name to one that is more descriptive of your document.
See next section for saving options.

Opening an existing Pocket Excel document
If you have previously created Pocket Excel documents, a list of the
documents appear after you tapped the Pocket Excel icon.

To open an existing Excel document:

1. Tap  , tap Programs, tap Pocket
Excel. to display a list of Pocket Excel
files.

2. Tap the file that you wish to open.
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To specify save options:

1. With the document open, tap Tools,
then tap File.

2. From the pop-up menu, tap Save
Workbook As... to display the Save
As screen.

3. Change the file name by simply typing
a new one in the Name field.

4. Tap the down arrow in the Folder field
to select a folder where you wish to
place the file.

5. Tap the down arrow in the Type field
to select a file format.

You can save the document you
create or edit in a variety of formats.

6. Tap the down arrow in the Location field to indicate the location of
your saved file, e.g. main memory, flash disk, or storage card, if
available.

7. Tap OK when done.

To rename/move a file:

1. With the document open, tap Tools,
then tap File.

2. From the second pop-up menu,  tap
Rename/Move... to display the
Rename/Move screen.

3. Change the file name in the Name
field.

4. Tap the down arrow in the Folder field
to select a folder where you wish to
move the file.

5. Tap the down arrow in the Location
box to select the folder location.

6. Tap OK when done.
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Securing your Excel document
If your workbook contains sensitive or confidental information, you can
protect it with a password.

To set a password for your workbook:
1. Open the workbook.

2. Tap Tools from the command bar,
then tap Password... to display
the password setting screen.

3. Type a password in the
Password field.

4. Re-type the password in the
Verify Password field.

5. Tap OK when done.

If you have set a password for your
workbook, a password screen
appears asking you to type your
password whenever you try to open
the workbook.

Type your password, then tap OK. If
you type in a wrong password, a
message appears telling you so.

NOTE DO NOT forget your password! You can not open your
workbook unless you type in the correct password.
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Tips for working in Pocket Excel
Take note of the following when working on large worksheets in Pocket
Excel:

• View in full-screen mode to see as much of your worksheet as
possible. Tap View, then tap Full Screen. To exit full-screen mode, tap
Restore.

• Show and hide window elements. Tap View, then tap the elements to
show or hide.

• Freeze panes on a worksheet. First select the cell where you want to
freeze panes. Tap View, then tap Freeze Panes. You might want to
freeze the top and leftmost panes in a worksheet to keep the row and
column labels visible as you scroll through a sheet.

• Split panes to view different areas of a large worksheet. Tap View, then
tap Split. Drag the split bar to where you want it. To remove the split, tap
View, then tap Remove Split.

• Show and hide rows and columns. To hide a row or column, select a
cell in the row or column that you want to hide. Tap Format, then tap
Row or Column, and tap Hide. To show a hidden row or column, tap
Tools, then tap Go To, and type a reference that is in the hidden row or
column. Tap Format, then tap Row or Column, and tap Unhide.

For more information on using Pocket Excel, tap  , then tap Help.
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MSN Messenger
MSN Messenger on your device is an instant messaging program that
allows you to:

• See who among your contacts is online

• Send and receive instant messages

• Have instant message conversations with groups of contacts

To use MSN Messenger:

You must have a Microsoft Passport™ account or a Microsoft
Exchange e-mail account.

You must have a Passport to use the MSN Messenger Service. If you
have a Hotmail® or MSN account, you already have a Passport. Once you
have obtained either a Microsoft Passport or Microsoft Exchange account,
you are ready to set up your account.

Sign up for a Microsoft Passport account at http://www.passport.com.

Get a free Microsoft Hotmail e-mail address at http://www.hotmail.com.

To launch MSN Messenger:

1. Tap  , then tap Programs.

2. Tap MSN Messenger.
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Signing up

To sign in to MSN Mesenger service:

NOTE If you already use MSN Messenger on your desktop
computer, your contacts will show up on your device.

1. Tap Tools then tap Sign in... from
the menu.

OR

Simply tap the Tap here to sign
in area.

2. In the sign-in screen, enter your
e-mail address and password.
Tap Sign In.
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Working with contacts
The MSN Messenger window shows all of your messenger contacts at a
glance, divided into Online and Not Online categories. From this view,
while connected, you can chat, send an e-mail, block the contact from
chatting with you, or delete contacts from your list using the pop-up menu.

To see others online without being seen, tap My Status in the Tools menu
and select Appear Offline.

If you block a contact, you will appear offline but will remain on the blocked
contact’s list. To unblock a contact, tap and hold the contact, then tap
Unblock on the pop-up menu.
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Chatting with contacts
Tap a contact name to open a chat window. Enter your message in the text
entry area at the bottom of the screen, or tap My Text to enter a preset
message, then tap Send. To invite another contact to a multi-user chat, tap
Invite in the Tools menu, then tap the contact that you want to invite.

NOTE To switch back to the main window without closing a chat, tap
the Contacts button. To go back to your chat window, tap
Chats and select the person whom you were chatting with.

To know if the contact you are chatting with is responding, look for the
message under the text entry area. For more information on using MSN
Messenger, tap  , then tap Help.
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Windows Media Player for Pocket PC
Use Microsoft® Windows Media Player for Pocket PC to play digital audio
and video files that are stored on your device or on a network. To switch to

Windows Media Player for Pocket PC, tap  , then tap Windows Media.

Use Microsoft Windows Media Player on your desktop computer to copy
digital audio and video to your Pocket PC. You can play Windows Media
and MP3 files on your Pocket PC.

For more information on using Windows Media Player for Pocket PC, tap
 , then tap Help.

Indicates the progress
of the current track

Tap to play or pause

Tap to stop
Tap to play the previous track

Tap to play the next track

Slide to adjust volume

Tap to mute sound
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Introduction
Use Microsoft Pocket Internet Explorer to view Web or WAP pages in any
of these ways.

• During synchronization with your desktop computer, download your
favorite links and mobile favorites that are stored in the Mobile Favorites
sub-folder in the Internet Explorer on the desktop computer.

• Connect to an Internet service provider (ISP) or network and browse the
Web. To do this, you need to create the connection first. See Chapter 8
for information on creating a connection.

When connected to an ISP or network, you can also download files and
programs from the Internet or intranet.

Using Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and
channels that have been downloaded to your device without connecting to
the Internet. You can also connect to the Internet through an ISP or a
network connection to browse the Web.

To launch Pocket Internet Explorer:

1. Tap  , then Internet Explorer
to display the Pocket MSN
services.

Tap to launch Favorites
Tap to go to Pocket Internet Explorer home

Tap to stop/refresh

Tap to go back to previous page

New Pocket MSN services
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2. Tap the Home button to display
the Pocket Internet Explorer
welcome screen with links to
some useful Web sites.

3. Tap any of the Web site buttons to
go to a specific site.

Changing View settings

To change View settings:

1. Tap View to display a pop-up menu.

2. Tap Layout to select a view option.

3. Tap Address Bar to display the Web
site address bar.

4. Tap and hold Text Size to display
another pop-up menu with a text size
selection. Select your desired text size
for the screen.

Browsing the Internet
To browse the Internet:

1. Set up a connection to your ISP or corporate network using
Connections. See Chapter 8 for details.

2. Do one of the following to connect and start browsing:

• Tap the Favorites button, then tap the favorite that you wish to view.

• Tap View, then Address Bar. Enter the Web address that you want
to visit then tap Go.
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AvantGo Channels
AvantGo is a free interactive service that gives you access to personalized
content and thousands of popular Web sites. You subscribe to AvantGo
channels directly from your device. Then, synchronize your device and
desktop computer, or connect to the Internet to download the content.

For more information, visit the AvantGo web site at http://avantgo.com/

To activate AvantGo:

1. In the ActiveSync window on your
desktop computer, click Options.

2. In the Sync Options tab, check
the box beside the AvantGo item.
Click OK.

ActiveSync automatically updates
the settings and synchronizes
with your device.

NOTE Make sure that your computer is connected to the Internet.

3. When synchronization is
complete, the AvantGo home
page appears on your device.

To launch AvantGo:

1. In Pocket Internet Explorer on
your device, tap the Favorites
button to display your list of
favorites.

2. Tap the AvantGo Channels link
to go directly to the AvantGo
home page and see a few of the
most popular channels.

To add or remove channels:

Tap the Add or Remove link.
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Mobile Favorites folder
Only the items stored in the Mobile Favorites sub-folder on your desktop
computer will be synchronized with your device. This folder was created
automatically when you installed ActiveSync.

Favorite links
During synchronization, the list of favorite links in the Mobile Favorites
folder on your desktop computer is synchronized with Pocket Internet
Explorer on your device. Both computers are updated with changes made
to either list each time you synchronize. Unless you mark the favorite link
as a mobile favorite, only the link will be downloaded to your device, and
you will need to connect to your ISP or network to view the content. For
more information on synchronization, see ActiveSync Help on the desktop
computer.

Mobile Favorites
If you are using Microsoft Internet Explorer 5.0 or later on your desktop
computer, you can download mobile favorites to your device.
Synchronizing mobile favorites downloads Web content to your device so
that you can view pages while you are disconnected from your ISP and
desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile
favorites quickly.
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To create a mobile favorite:

1. In Internet Explorer on your desktop
computer, click Tools then Create
Mobile Favorite.

2. To change the link name, enter a new
name in the Name box.

3. Select your desired update schedule
in Update. This is optional.

4. Click OK. Internet Explorer downloads
the latest version of the page to your
desktop computer.

5. If you want to download the pages that
are linked to the mobile favorite you
just created, in Internet Explorer on the
desktop computer, right-click the
mobile favorite, then click Properties.
In the Download tab, specify the
number of links deep you want to
download. To conserve device
memory, go only one level deep.

6. Synchronize your device and your
desktop computer. Mobile favorites that
are stored in the Mobile Favorites
folder in Internet Explorer are
downloaded to your device.

NOTE If you did not specify an update schedule in step 3, you will
need to manually download content to keep the information
updated on your desktop computer and device. Before
synchronizing with your device, in Internet Explorer on your
desktop computer, click Tools then Synchronize. You will
see the last time content was downloaded to the desktop
computer, and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for
creating mobile favorites. In Internet Explorer on your desktop
computer, click View, Toolbars, and Customize.
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Viewing mobile favorites and channels

To view mobile favorites and channels:

1. Tap  to display your list of favorites.

2. Tap a Favorites page that you wish to view.

You will see the page that was downloaded the last time you
synchronized with your desktop computer. If the page is not on your
device, the favorite is dimmed. You need to synchronize with your
desktop computer again to download the page to your device, or
connect to the Internet to view the page.

Tap the favorite that
you wish to view

Tap to add or delete a
folder or favorite link

Saving device memory
Mobile favorites take up storage memory on your device. To minimize the
amount of memory used:

• In the settings for the Favorites information type in ActiveSync options,
turn off pictures and sounds, or stop some mobile favorites from being
downloaded to the device. For more information, see ActiveSync Help.

• Limit the number of downloaded linked pages. In Interner Explorer on
your desktop computer, right-click the mobile favorite you want to
change, then click Properties. In the Download tab, specify 0 or 1 for
the number of linked pages you want to download.
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Adding/Deleting mobile favorites and folders

To add a favorite:
1. Tap  to display your list of

favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Tap the Add... button to show the
Add Favorite screen.

4. Type a name for the favorite that
you wish to add in the Name field.

5. Type in the URL address in the
Address (URL) field.

6. Select a folder to place the
favorite from the Create in: box.

7. Tap Add to return to the Favorites
screen, which now shows the
favorite that you added.

To delete a favorite:

1. Tap  to display your list of
favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Select the favorite that you wish
to delete, then tap Delete.

4. When prompted to permanently
delete the favorite, tap Yes.
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To add a folder:

1. Tap  to display your list of
favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Tap the New Folder button.

4. Type a name for the folder that
you wish to create.

5. Tap Add to return to the Favorites
screen, which now shows the
folder that you added.

To delete a folder:

1. Tap  to display your list of
favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Select the folder that you wish to
delete, then tap Delete.

4. When prompted to permanently
delete the folder, tap Yes.
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Introduction
You can set up connections to the Internet and corporate network at work
to do such activities as browse the Internet or intranet, send and receive e-
mail and instant messages, and synchronize information using ActiveSync.

Connections can be made using a modem, wireless network, or
network (Ethernet) card. A modem connection can be used to set up
connections with an external modem, or through your mobile phone
network using a cellular line.

Your device has two groups of connection settings: My ISP and My Work
Network. My ISP settings are used to connect to the Internet, and My
Work Network settings can be used to connect to any private network,
such as a corporate network you use at work. Simply fill in the settings and
get ready to start connecting. For more information, see the sections
“Connect to the Internet” or “Connect to Work.”

You may also establish connection to another device with infrared (IR) or
Bluetooth features. For more information, see the section “Infrared (IR)
connection” later in this chapter, or “Chapter 9  Bluetooth® connection.”

Connect to the Internet

To connect to the Internet:

1. Obtain the following information from your ISP:  ISP server phone
number, user name, and password.

2. Tap   > Settings > Connections tab > Connections.

3. In My ISP, tap Add a new modem connection.

4. Create a modem connection. For more information, see section “Set
up modem connections.”

5. To start the connection, begin using the desired program. For example,
switch to Pocket Internet Explorer and browse a Web page. Your
device automatically connects.

NOTE To set up a network card or wireless network connection to
your ISP, add a new connection under My Work Network.



Get connected 8-3

Connect to Work
1. Obtain the following information from your network administrator:

server phone number, user name, and password.

2. Tap   > Settings > Connections tab > Connections.

3. In My Work Network, set up either a modem, network card, wireless
network, or VPN server connection. Refer to the section “Set up
connections” for the procedure.

4. To start the connection, start using a desired program. For example,
switch to Pocket Internet Explorer and browse to a Web page. Your
device automatically starts connecting.

Set up connections

Modem connections

To set up a modem connection:

Obtain the following information from your ISP or network administrator:
telephone number, user name, password, domain name, and TCP/IP
settings.

If your device does not have access to a mobile phone network, insert a
modem card.

1. Tap   > Settings > Connections tab > Connections.

2. To create a new connection, in either My ISP or My Work Network,
tap Add a new modem connection, then follow the instructions in the
New Connection wizard.

3. To view additional information for any screen in the wizard or while

changing settings, tap .

NOTE To change modem connection settings in either My ISP or My
Work Network, tap Manage existing connections. Select
the desired modem connection, tap Settings, and follow the
instructions on the screen.
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VPN server connections
A VPN connection helps you to securely connect to servers, such as a
corporate network, via the Internet. Ask your network administrator for your
user name, password, domain name, TCP/IP settings, and host name or
IP address of the VPN server.

To set up a VPN server connection:

1. Tap   > Settings > Connections tab > Connections.

2. To create a new VPN server connection, in My Work Network, tap Add
a new VPN server connection, then follow the screen instructions.

3. To view additional information for any screen in the wizard or while

changing settings, tap .

NOTE To change existing settings, in My Work Network, tap
Manage existing connections > VPN tab. Select your
desired VPN connection, tap Settings, then follow the
instructions on the screen.

Proxy server settings
If you are connected to your ISP or private network during synchronization,
your mobile device should download the proper proxy settings from your
PC. If these settings are not on your PC or need to be changed, ask your
ISP or network administrator for the proxy server name, server type, port,
type of Socks protocol used, and your user name and password.

To change proxy server settings:

1. Tap   > Settings > Connections tab, then tap the Connections
icon.

2. Under My Work Network category, tap Edit my proxy server.
3. Check the boxes beside This network connects to the Internet and

This network uses a proxy server to connect to the Internet.
4. In the Proxy server box, enter the proxy server name.

5. To change the server and port settings for HTTP, WAP, Secure WAP,
and Socks, tap Advanced.

6. Tap OK when done.
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Network card connections
Use a network (Ethernet) card to connect directly to a network. Once
connected, you can view the Internet or intranet, or download e-mail. You
do not need to create a new connection on your device. For more
information, see your network administrator. Make sure to purchase and
configure a network card that is compatible with your device.

To set up a network card:

1. Obtain the following information from your network administrator: user
name, password, and domain name.

2. Insert the network card into your device.

3. The first time you insert the card, Network Settings appears
automatically so that you can configure the network card. If it does not
appear, or to change settings later, tap   > Settings > Connections
tab > Network Cards.

4. If you need to enter specific server information, tap the appropriate
adapter, and then tap Properties. Most networks use DHCP, so you
should not have to change these settings unless your network
administrator instructs you to do so.

5. If necessary, connect the network card to the network by using a
network cable. For information, refer to the documentation that came
with your network card.

6. To start a connection, insert the network card, and begin using a
desired program. For example, switch to Pocket Internet Explorer
and browse a Web page. Your device automatically starts connecting.

If you use your network card with two networks, such as a private
network at work and one at home for the Internet, you need to change
the network to which the network card connects.

NOTE You may need proxy server and VPN connection settings.
For more information, see your network administrator.



8-6 Chapter 8

End a connection
• When connected via modem or VPN, tap   on the navigation bar,

then tap Disconnect.

• When connected via cable or cradle, detach your device from the cable
or cradle.

• When connected via Infrared, move the device away from the other
computer or device.

• When connected via a network (Ethernet) card, remove the card from
your device.

• When connected via a wireless network, switch off the connection.

Set up a WAP gateway
To access WAP sites through Pocket Internet Explorer, configure your
device to use a WAP gateway. Use the following steps to create a new set
of connections to the Internet with WAP gateway settings.

NOTE Some device models do not support the WAP sites viewing
feature.

1. Get the following information from your ISP: ISP server phone number,
user name, and password. Also, contact your mobile phone service
provider and ask for your WAP gateway server name and port number.

2. Tap   > Settings > Connections tab > Connections > Tasks tab.

3. Tap Edit my proxy server. If a proxy server has not been set up, tap
Set up my proxy server.

4. In Programs that automatically connect to the Internet should
connect using, tap New and enter a name for the ISP connection.

5. On the Proxy Settings tab, select This network connects to the
Internet and This network uses a proxy server to connect to the
Internet.

6. If necessary, in the Proxy server box, enter the proxy server name.

7. Tap Advanced.

8. In the WAP box, enter the WAP gateway server name. Under Port,
enter the port number. The most common WAP port number is 9201.
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Use dialing rules
Additional numbers may need to be dialed depending on your given
location when connecting. For example, if you want to dial from work, a 9
prefix must often be dialed, or an area code is needed.

To avoid creating a new modem connection for each situation, set dialing
rules for the locations from which you connect often. Three dialing
locations, Home, Mobile, and Work, have been created for you, and you
can create more. If a connection cannot be made, your device gives you
an opportunity to change the dialing location.

1. Tap   > Settings > Connections tab > Connections > Advanced
tab.

2. Tap Dialing Rules...
3. Tap the box beside Use dialing rules.

4. Select a location.

• Home - Dials the number as a local call without the prefix 9.

• Work - Dials the number as local call with the prefix 9.

NOTE To create a new location, tap New and follow the directions
on the screen. To view additional information at any time,

tap .

9. Create a modem connection. See section “Set up connections.”

If necessary, set dialing rules. See section “Use dialing rules.”

10. If your device does not have a connection to a mobile phone network,
insert a modem card.



8-8 Chapter 8

Infrared (IR) connection

Setting beam options

To set the beam options:

1. Tap  , then Settings.

2. Tap the Connections tab.

3. Tap the Beam icon to display the
Settings screen.

4. By default, your device detects
incoming infrared (IR) beams and
prompts you to accept them. If you do
not want your device to detect or
receive beans, clear the Receive all
incoming beams check box.
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Receiving infrared beams

To receive a file via infrared beam:

1. From the Beam settings screen, tap the link Receive an infrared
beam. Your device automatically looks for another device using
infrared. Tap Cancel if you wish to abort the command.

2. If your device did not find a sending device through the IR port, a
message appears informing you of such. Tap Close to return to the
previous screen.

2. If an infrared device within range
beams a file or data to you, a
message prompts you to receive it.
Tap Yes to receive or No to reject.

NOTE Make sure to align the IR
ports so that they are
unobstructed and within the
required range.
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Sending infrared beams

To send a file via infrared beam:

1. Tap and hold a file to beam, then tap Beam File... from the pop-up
menu.

2. Align the IR ports of the devices so that they are unobstructed and
within a close range. If the ports are not aligned, a message appears
asking you to do so.

When an IR port is found, a screen message appears indicating the
sending process.

The message Done appears when the file transfer is complete.
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Introducing Bluetooth®

Bluetooth is a short-range wireless communications technology. Devices
with Bluetooth capabilities can exchange information over a distance of
about 10 meters (30 feet) without requiring a physical connection.

Unlike infrared, you do not need to line up the devices to beam information
with Bluetooth. The devices only need to be within a range of about 10
meters. You can even beam information to a device in a different room, as
long as it is within the specified range.

NOTE If you experienced problems using Bluetooth® in a landscape
display orientation, revert to portrait. See page 2-19 for details.

Bluetooth® for Windows® CE (BTW-CE)
BTW-CE is the solution to smoothly integrate the Bluetooth technology into
devices that use the Pocket PC operating system.

The Bluetooth technology allows your Pocket PC to:

• Locate other Bluetooth devices within the vicinity
• Discover the services that those devices offer
• Connect to, use, and disconnect from those services
• Enable or disable individual services
• Use security features including authentication, authorization, and

encryption

Bluetooth icon
The Bluetooth icon is located on the lower
right corner of the Today screen.

When Bluetooth is enabled (turned ON),
the icon is blue  , and the Bluetooth LED
on the left side of the device blinks blue.

When Bluetooth is disabled (turned OFF),
the icon is grayed with a red X on its lower
right corner .

Tapping the icon displays a menu that
allows you to:

• turn Bluetooth on or off
• launch the Bluetooth Manager
• change the Bluetooth Settings

Bluetooth icon



Bluetooth® 9-3

Bluetooth settings

To configure the Bluetooth settings:

1. Tap  from the lower right corner of
the Today screen to display the
Bluetooth menu.

2. Tap Bluetooth Settings.

3. Tap one of the tabs at the bottom of
the Settings screen to make your
desired changes.

General
Allows you to:

• select the user profile

• see the Bluetooth status (ON/OFF)

• turn Bluetooth ON or OFF

• tap a link to the Bluetooth Manager

Accessibility
Allows you to:

• set the device name

• see the Bluetooth Device Address (BDA)

• select the remote devices you wish to
connect

• set whether to allow remote devices to
see your device
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File Transfer
Allows you to customize the settings for
file transfers, and set the highest level
directory on your device that remote
devices can access.

Refer to section “Remote device
services” for more information.

Information Exchange
Allows you to customize the service
settings, and set the default business
card.

Serial Port
Allows you to customize the service
settings, and display the serial port
addresses. The port address
assignments cannot be changed.

Refer to section “Remote device
services” for more information.
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Personal Network Server
Allows you to customize the service
settings for your personal network
server.

Refer to section “Remote device
services” for more information.

Audio Gateway
Allows you to customize the service
settings for the Audio Gateway.

About
Displays the Bluetooth™ for Windows®

CE (BTW-CE) information including the
release version, copyright notice,
website address, technical support
email, and the Advanced button. The
Advanced buttons contains the version
information about the individual software
modules that make up BTW-CE.

The information on this screen is not
configurable.
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Bluetooth Manager
The Bluetooth Manager allows you to create, manage, and use Bluetooth
to connect to remote devices.

To launch the Bluetooth Manager:

1. Tap  from the lower right corner of
the Today screen to display the
Bluetooth menu.

2. Tap Bluetooth Manager.

The My Shortcuts screen displays a list of pre-configured connections, if
any. Tap New > Connect to connect to other devices via Bluetooth.

The Active Connections screen displays the active incoming and outgoing
connections.

Tap to make a new connection
Tap to add or remove paired devices

Tap to set view options
Tap to launch the Bluetooth connection wizard

Tap to set Business Card exchange options



Bluetooth® 9-7

Bluetooth connection wizard
The Bluetooth connection wizard helps you set up connections with
remote Bluetooth devices.

To launch the Bluetooth connection wizard:

1. Tap   from the Bluetooth Manager
command bar. The Bluetooth
Connection Wizard screen appears.

2. Select a type of connection that you
wish set up. Tap Next.

Tap Cancel if you do not wish to
continue the connection process.

NOTE Refer to the device online help for other information on
Bluetooth.
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Business Card Exchange
The Business Card Exchange function allows you to:

• send your business card to a remote device

• receive a business card from a remote device

• exchange business cards with one or more remote devices

To launch the Business Card Exchange screen:

1. Tap    from the  Bluetooth Manager
command bar.

2. Select the action that you wish to
make.

NOTE From this screen, tap the link Select the business card to
go to the Information Exchange settings.
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Remote device services

Wireless serial port
Using a Bluetooth serial port is equivalent to using a physical cable serial
port connection between two devices. As with a physical connection, you
have to configure the application that will use the serial port.

To configure the Bluetooth Serial Port:

1. Tap  from the lower right corner
of the Today screen to display the
Bluetooth menu.

2. Tap Bluetooth Settings, then the
Serial Port tab.

3. Note the assigned Outbound
COM Port 6 and configure the
application that will use the
Bluetooth serial port to send data
to this port.

NOTE Refer to the application’s documentation for more information
about configuring your application’s Outbound COM port.

4. From the Bluetooth Manager My Shortcuts screen, open the Bluetooth
Serial Port connection to the remote device.

5. Send/receive data from the application.
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Dial-up networking
The Dial-up Networking feature allows you to connect to a remote
computer through a phone line. Once connected, you can browse the
Internet, check/read emails, etc.

NOTE The remote Bluetooth device that will provide the Dial-up
Networking service should have access to a telephone
system, either a hard-wired or a cellular connection, and
capable of answering a call.

Devices that may provide a Dial-up Networking service:

• Bluetooth-enabled cellular telephones

• Bluetooth-enabled desktop computers attached to a telephone system

• Bluetooth modems

To use Dial-up Networking:

1. Create a connection to the device that will provide telephone access.
See the section “Bluetooth connection wizard” on page 9-7.

2. Tap  , then the Bluetooth Manager from the Start menu.

3. In My Shortcuts screen, tap and hold the Dial-up Networking
Connection shortcut, then select Connect from the pop-up menu.

4. On the first Bluetooth: Dial-up Connection screen, double-tap New
Connection... OR select New Connection then tap OK.

5. Key-in the following informatin on the second Bluetooth: Dial-up
Connection screen:

• Name for a connection

• Country code (if dialing outside the default country setting)

• Area code (if dialing outside the default area code setting)

• Phone number to be dialed

6. Tap  OK.

7. Enter the required information on the succeeding screens to complete
the connection process.

8. When the connection is active, open a web browser from the device.
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Bluetooth file explorer
The Bluetooth File Explorer appears automatically after a file transfer
connection is established.

This service feature allows you to do the following operations:

• Navigate the directory structure of the remote device

• View the files and folders on the remote device

• Create new folders on the remote device

• Send files to, and copy or get  files from the remote device

• Delete files from the remote device

NOTE The file operations on the remote device are limited to the
configured FTP root directory and sub-directories of the
remote device.

The Bluetooth File Explorer also allows you to set a folder in your device
for receiving inbound files. You may configure this folder for each of your
connection shortcuts. See the section “To set a local folder” on page 8-13.

Bluetooth File Explorer menus

File Send a File...
Create a Folder
Get
Delete

Tools Set Local Folder
Refresh

To change the remote device folder:

1. To move down in the directory structure of the remote device, tap the
New Folder from the main window of Bluetooth File Explorer.

2. To move up in the directory structure of the remote device, tap the
down-arrow to the right of the currently selected folder and select the
New Folder from the drop-down list.
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To create a folder on the remote device:

1. Select the folder in which you wish to place the new folder.

2. From the File menu, tap Create a Folder.
3. Enter a name for the new folder while the default name New Folder is

highlighted.

To send a file to the remote device:

1. From the File menu, tap Send a File... to display the Open screen.

The Open screen includes the following:

Folder - tap the down-arrow and select the folder that contains the file
you wish to send

Type - default and only option is “All Files (*.*)

A list of files in  the selected folder - tap a file that you wish to send

Cancel button - abort the Send a File... operation

2. Tap your desired operation.

The file that you selected is automatically sent when tapped, after
which the Bluetooth File Explorer re-appears.

To get a file from the remote device:

1. Select the folder containing the file.

2. Tap the file that you wish to get or copy.

3. From the File menu, tap Get.

OR

Tap and hold the desired file and select Get from the pop-up menu.

The file is copied to the local folder listed in the Local Folder field at the
bottom of the screen.

To delete a file from the remote device:

1. Tap the file that you wish to delete.

2. From the File menu, tap Delete.

3. Tap OK in the confirmation dialog box.

OR

Tap and hold the desired file and select Delete from the po-up menu.
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To set a local folder for incoming files:

1. From the Tools menu, tap Set Local Folder.
2. Use the drop-down menu at the top of the screen to go to your desired

folder.

3. Tap OK to return to the main screen of Bluetooth File Explorer. You will
see the Local Folder field is updated to reflect the new folder selection.

NOTE The Local Folder information is associated with the currently
open shortcut and is saved with the active profile. You can
separately configure your Local Folder for each connection
shortcut.

To refresh the list of displayed files and folders on the remote device,
simply tap Refresh from the Tools menu.
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Send via Bluetooth
You can conveniently send your Pocket Outlook contacts, calendar items,
and tasks individually or collectively to the remote device via Bluetooth.

To send data via Bluetooth:

1. Tap   , then either Contacts,
Calendar, or Tasks.

2. Highlight an item that you wish to
send to the remote device.

3. Tap and hold the item, then tap
Send via Bluetooth from the
pop-up menu.

OR

Tap Tools from the command bar,
then select Send via Bluetooth.

4. On the Select a Bluetooth Device
screen, tap the name of the
destination, then tap OK.
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Dial via Bluetooth
The Dial via Bluetooth option allows you to select a contact from the
Pocket Outlook contacts list, and have your paired cell phone dial the
contact’s phone number. If a contact has more than one phone number,
select the number that you wish to dial. You may also modify a phone
number before you dial.

To dial via Bluetooth:

1. From the Pocket Outlook Contacts screen, tap and hold a contact and
select Dial via Bluetooth.

2. If your device is paired with more than one cell phone, or if a phone is
not yet selected, tap the phone icon next to Select a phone, and
choose the phone that you wish to use.

3. Select the number that you wish to dial, then tap Dial Number.
4. To modify the number, tap Edit Number and make your desired

changes. Tap OK to return to the previous screen.

NOTE If you modify a phone number, a dialog box appears with an
option to save or to discard the modification.

5. Tap Dial Number.
After the number is sent to the cell phone, the connection on the
device is closed.

After the cell phone completes the dialing process, you can use the
use the phone the normal way.
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Bluetooth Personal Area Network
A Bluetooth personal area network is a private, temporary, ad-hoc network
of up to eight (8) devices. A Bluetooth personal area network allows you to
easily exchange information that normally requires a TCP/IP network.
Most chat utilities, multi-player games, etc. are fully functional in a
Bluetooth personal area network environment.

Bluetooth private area networks are subject to the same security settings
(service availability, authorization, authentication, and encryption) that
govern other Bluetooth communications.

One Bluetooth device must be the host of the personal area network.
Other Bluetooth devices join the network as clients. The host can accept
and reject clients on an individual basis.

To set up a Bluetooth personal area network:

1. From the Bluetooth Manager,
select New>Connect> Join a
personal network. Tap Next.

2. On the wizard screen, select Host
a personal network, then tap
Next.

3. Add remote devices to the
Bluetooth personal network, if
desired.

a. Tap the Add button and select
the device that you wish to
add.

b. Add other devices, if desired.
There can be up to eight
devices, including the host.

4. After adding devices, tap OK to
complete the setup and close the
wizard.

NOTE Adding devices is optional. You do not have to add devices to
the personal network while configuring the host. You can let
other devices join the personal network later.
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To join a personal network:

1. From the Bluetooth Manager,
select New>Connect>Join a
personal network. Tap Next.

2. On the wizard screen, select Join
a personal network, then tap
Next. The Bluetooth browser
appears.

3. Select the host of the personal
network, then tap Next to
establish a connection to the
personal area network.

If you are asked to enter the IP
network settings, select Use
server-assigned IP address,
then tap OK.
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Introducing Wi-Fi®

MyPal comes with a built-in Wireless Fidelity (Wi-Fi®) feature that allows
you to connect to wireless local area networks and the Internet. Using the
IEEE 802.11b standard for wireless LAN, MyPal can connect at speeds of
up to 11 Mbps to an access point (Infrastructure mode) or to another
wireless device (Ad-hoc mode).

Accessing the Wi-Fi feature
The Wi-Fi icon on your Today screen allows you easy access to the Wi-Fi
(Wireless Fidelity) feature on your device. Tapping the icon displays a
menu that allows you to:

• turn Wireless LAN on or off

• show the Wi-Fi information

• configure the Wi-Fi Settings

NOTE You can use the Bluetooth®

and Wi-Fi features
simultaneously.

Wireless LAN icon

Using Wi-Fi

Turning on Wi-Fi

To turn on the Wi-Fi:

1. Tap the  icon on the command bar.

2. Tap the option Turn Wi-Fi On. The
system automatically scans for all
available wireless networks within the
Wi-Fi range.
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3. From the list of detected wireless
networks, select a wireless network to
you want to connect your device.

4. Select either The Internet or Work for
the network to connect your device.

5. Tap Connect. The device connects to
the selected network.

Configuring wireless networks

To configure a wireless network:

1. After selecting a network to connect
your device, tap Settings instead of
Connect.

2. Tap on an available wireless LAN,
then make your desired changes as
necessary.

If the wireless LAN you want to
connect to is not on the list, tap Add
New... Refer to the suceeding sections
for details on how to add new wireless
LANs.

3. Tap OK when done.



10-4 Chapter 10

To configure a network adapter:

1. Tap the Network Adapters tab.

2. Make your desired changes to the
available adapters on the list.

3. Tap OK when done.

Adding a wireless network
If the device fails to auto-detect the wireless network you want to connect,
you can add the network provided you know the wireless network settings.
Inquire the wireless network settings with your network administrator
before your proceed.

To add a wireless network:

1. Open the Configure Wireless
Networks window by:

• Tapping on Settings in the
Multiple Networks Detected
callout.

OR

• Tapping  > Configure Wi-Fi.

4. After changing the network adapter
settings, a message appears
instructing you to remove then re-
install the network card to have your
changes take effect. Tap OK to close
the window.
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2. Tap Add New... from the wireless
networks field.

3. Use the input panel to key-in the
Network name.

4. Select The Internet or Work network
you wish to connect to through the
wireless network.

5. If you want to connect to another
wireless device (Ad-hoc mode), check
the option This is a device-to-device
(ad-hoc) connection.

Otherwise, tap the Network Key tab
to configure the wireless LAN network
security settings.

3

4

5

6. In the Network Key tab, select the
Authentication and Data Encryption
settings of the wireless LAN you want
to add.

NOTE Inquire the network security
settings with the network
administrator.

7. Tap the 802.1x tab to configure other
network security settings.

Otherwise, tap OK to add the wireless
network.
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8. The created wireless network is
displayed in the list of wireless
networks.

Tap the wireless network to connect.

Network association
To associate with one of the detected wireless networks:

1. Tap and hold on a wireless network, then tap Connect from the pop-up
menu.

NOTE Another way to connect to a wireless network is to tap the
network entry twice.

2. If the wireless network that you selected is on the profile, the device
tries to connect to the wireless network automatically without asking for
additional information. Otherwise, key-in the required network
information.

3. After you have entered the required network information, tap OK. The
wireless network is then added to the profile, and your device will try to
connect to it.
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Wi-Fi information
You can view the Wi-Fi information by
tapping , and selecting Wi-Fi
Information from the menu.

NOTE You can view the Wi-Fi
information even when the
device is disconnected from
a wireless network.

Wi-Fi Status
This tab displays the current state and link
information of your Wi-Fi device, and
allows you to re-scan the available
wireless networks when necessary by
tapping the Rescan button.

The Rescan button allows you to search
for all available access points and
wireless devices (ad-hoc networks) in
your location.

If your signal strength is poor, you can use
re-scanning to push the radio off a weak
AP and search for a better link with
another AP. The re-scanning process may
take several seconds.

See the next page for a description of each Wi-Fi information displayed in
the Wi-Fi Status tab.
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Status
This field shows the Wi-Fi connection status.

• Connected - the station is associated with one wireless LAN
device. This status also indicates the MAC address
of the device.

• Disconnected - a previous link existed but no beacon was received.
The connection to the adapter is terminated.

ESSID
This field shows the Extended Service Set Indenfier (ESSID) to which the
wireless device is connected. The text on this field is usually an
unreadable alphanumeric string.

BSSID
This field shows the Basic Service Set ID (BSSID) to which the wireless
device is connected. In ESS mode, this is the MAC address of the access
point to which your device is connected.

BSS Mode
This field tells you whether the device is connected to an access point
(Infrastructure mode) or to another wireless device (Ad-hoc mode).

Encryption
This field tells you whether or not the wireless network uses data
encryption.

Signal Strength
This field shows the signal strength level between the Wi-Fi device and the
access point (or another wireless device) to which it is currently connected.
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ESSID
This column shows the Extended Service Set Indenfier (ESSID) of the
wireless network found in the search.

CH
This column shows the channel used by the wireless device.

Table of icon indications

Icon Indicates that the wireless network is

an Access Point with disabled Wired Equivalent Privacy (WEP) encryption

an Access Point with enabled WEP encryption

an Access Point with disabled WEP encryption and MyPal is currently
connected to this network

an Access Point with enabled WEP encryption and MyPal is currently
connected to this network

a wireless device with disabled WEP encryption

a wireless device with enabled WEP encryption

a wireless device with disabled WEP encryption and MyPal is currently
connected to this network

a wireless device with enabled WEP encryption and MyPal is currently
connected to this network

Site Survey
This tab allows you to search for available
wireless networks within your location.
Tap the Search button to scan all
available wireless networks and display
the results on the screen.

Each wireless network is preceded by an
icon for easy identification. The network
channel, RSSI, and BSSID are also
displayed in columns. Refer to the table of
icon indications and column descriptions
below.
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RSSI
This column shows the Received Signal
Strength Indication (RSSI) transmitted
by each wireless network. This
information is helpful in determining
which network you wish to associate
your device. This signal  is normally
represented by a dBm value.

BSSID
This column shows the Media Access Control (MAC) address of the
access point, or the Basic Service Set ID (BSSID) in an ad-hoc mode.

Icon Link Quality

Excellent

Good

Fair

Poor

IP Info
When connected to a wireless network,
the Wi-Fi Information window opens the
IP Info tab that displays the device
Internet Protocol (IP) information including
the host name, domain, DNS server, IP
address, etc.

This tab also allows you to renew the IP
address when the wireless network uses
the Dynamic Host Configuration Protocol
(DHCP).

Pressing the Renew button forces the
device to refresh its server-assigned IP
address. The process may take several
seconds while the system updates the IP
information.
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About
This page displays the Wi-Fi utility and
driver version information of your Wi-Fi
device.

For updated product information, technical
support, and downloads, visit the ASUS
web site at http://www.asus.com.
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Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

1) This device may not cause harmful interference, and

2) This device must accept any interference received, including interference that may cause
undesired operation.

This device and its antenna must not be co-located or operating in conjunction with any other
antenna or transmitter.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with
manufacturer’s instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital
apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

WARNING! The use of shielded cables for connection of the monitor to the
graphics card is required to assure compliance with FCC regulations.
Changes or modifications to this unit not expressly approved by the
party responsible for compliance could void the user’s authority to
operate this equipment.
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UL Safety Notices
Required for UL 1459 covering telecommunications (telephone) equipment intended to be
electrically connected to a telecommunication network that has an operating voltage to ground that
does not exceed 200V peak, 300V peak-to-peak, and 105V rms, and installed or used in
accordance with the National Electrical Code (NFPA 70).

When using the Pocket PC, basic safety precautions should always be followed to reduce the risk
of fire, electric shock, and injury to persons, including the following:

• Do not use the Pocket PC near water, for example, near a bath tub, wash bowl, kitchen sink
or laundry tub, in a wet basement or near a swimming pool.

• Do not use the Pocket PC during an electrical storm. There may be a remote risk of electric
shock from lightning.

• Do not use the Pocket PC in the vicinity of a gas leak.

Required for UL 1642 covering primary (non-rechargeable) and secondary (rechargeable) lithium
batteries for use as power sources in products. These batteries contain metallic lithium, or a lithium
alloy, or a lithium ion, and may consist of a single electrochemical cell or two or more cells
connected in series, parallel, or both, that convert chemical energy into electrical energy by an
irreversible or reversible chemical reaction.

• Do not dispose the Pocket PC battery pack in a fire, as they may explode. Check with local
codes for possible special disposal instructions to reduce the risk of injury to persons due to fire
or explosion.

• Do not use power adapters or batteries from other devices to reduce the risk of injury to
persons due to fire or explosion. Use only UL certified power adapters or batteries supplied by
the manufacturer or authorized retailers.

Replaceable batteries
If an equipment is provided with a replaceable battery and if replacement by an incorrect type could
result in an explosion (e.g. with some lithium batteries), the following applies:

– if the battery is placed in an OPERATOR ACCESS AREA, there shall be a marking close
to the battery or a statement in both the operating and the servicing instructions;

– if the battery is placed elsewhere in the equipmen, there shall be a marking close to the
battery or a statement in the servicing instructions.

The marking or statement shall include the following or similar text:
CAUTION

RISK OF EXPLOSION IF BATTERY IS REPLACED
BY AN INCORRECT TYPE.

DISPOSE OF USED BATTERIES ACCORDING
THE INSTRUCTIONS

Compliance is checked by inspection.

Operator access with a tool
If a TOOL is necessary to gain access to an OPERATOR ACCESS AREA, either all other
compartments within that area containing a hazard shall be inaccessible to the OPERATOR by the
use of the same TOOL, or such compartments shall be marked to discourage OPERATOR access.

An acceptable marking for an electric shock hazard is (ISO 3864, No. 5036)

Equipment for restricted access locations
For equipment intended only for installation in a RESTRICTED ACCESS LOCATION, the
instalation instructions shall contain a statement to this effect.
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